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LIST OF EFFECTIVE PAGES 
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Sign Off ........................... * 130/FIN A 
FS ii ................................. * 130/FIN A 
FS iii ................................ * 130/FIN A 
FS iv ................................ * 130/FIN A 
FS v ................................. * 130/FIN A 
FS vi ................................ * 130/FIN A 
FS vii ............................... * 130/FIN A 
FS viii .............................. * 130/FIN A 
FS ix ................................  130/FIN A 
FS x .................................  130/FIN A 
1-i ....................................  generic 
1-ii ...................................  generic 
FS 1-1 .............................  130/FIN A 
FS 1-2 .............................  130/FIN A 
FS 1-3 .............................  130/FIN A 
FS 1-4 ............................. ⊗ 130/FIN A 
FS 1-5 .............................  130/FIN A 
FS 1-6 .............................  130/FIN A 
FS 1-7 .............................  130/FIN A 
FS 1-8 .............................  130/FIN A 
FS 1-9 .............................  130/FIN A 
FS 1-10 ...........................  130/FIN A 
FS 1-11 ...........................  130/FIN A 
FS 1-12 ...........................  130/FIN A 
FS 1-13 ...........................  130/FIN A 
FS 1-14 ........................... ⊗ 130/FIN A 
FS 1-15 ...........................  130/FIN A 
FS 1-16 ...........................  130/FIN A 
FS 1-17 ...........................  130/FIN A 
FS 1-18 ...........................  130/FIN A 
FS 1-19 ...........................  130/FIN A 
FS 1-20 ...........................  130/FIN A 
FS 1-21 ...........................  130/FIN A 
FS 1-22 ...........................  130/FIN A 
FS 1-23 ...........................  130/FIN A 
FS 1-24 ........................... ⊗ 130/FIN A 
FS 1-25 ...........................  130/FIN A 
FS 1-26 ...........................  130/FIN A 
FS 1-27 ...........................  130/FIN A 
FS 1-28 ...........................  130/FIN A 
FS 1-29 ...........................  130/FIN A 
FS 1-30 ...........................  130/FIN A 
FS 1-31 ...........................  130/FIN A 
FS 1-32 ...........................  130/FIN A 
FS 1-33 ...........................  130/FIN A 
FS 1-34 ........................... ⊗ 130/FIN A 
FS 1-35 ...........................  130/FIN A 
FS 1-36 ...........................  130/FIN A 

FS 1-37 ............................  130/FIN A 
FS 1-38 ............................  130/FIN A 
FS 1-39 ............................  130/FIN A 
FS 1-40 ............................ ⊗ 130/FIN A 
FS 1-41 ............................ ⊗ 130/FIN A 
FS 1-42 ............................  130/FIN A 
FS 1-43 ............................  130/FIN A 
FS 1-44 ............................  130/FIN A 
FS 1-45 ............................  130/FIN A 
FS 1-46 ............................  130/FIN A 
FS 1-47 ............................  130/FIN A 
FS 1-48 ............................ ⊗ 130/FIN A 
FS 1-49 ............................  130/FIN A 
FS 1-50 ............................  130/FIN A 
FS 1-51 ............................  130/FIN A 
FS 1-52 ............................ ⊗ 130/FIN A 
FS 1-53 ............................  130/FIN A 
FS 1-54 ............................  130/FIN A 
FS 1-55 ............................  130/FIN A 
FS 1-56 ............................  130/FIN A 
FS 1-57 ............................  130/FIN A 
FS 1-58 ............................  130/FIN A 
FS 1-59 ............................  130/FIN A 
FS 1-60 ............................  130/FIN A 
FS 1-61 ............................  130/FIN A 
FS 1-62 ............................  130/FIN A 
FS 1-63 ............................ ⊗ 130/FIN A 
FS 1-64 ............................  130/FIN A 
FS 1-65 ............................  130/FIN A 
FS 1-66 ............................  130/FIN A 
FS 1-67 ............................  130/FIN A 
FS 1-68 ............................  130/FIN A 
FS 1-69 ............................  130/FIN A 
FS 1-70 ............................  130/FIN A 
FS 1-71 ............................  130/FIN A 
FS 1-72 ............................  130/FIN A 
FS 1-73 ............................  130/FIN A 
FS 1-74 ............................  130/FIN A 
FS 1-75 ............................  130/FIN A 
FS 1-76 ............................  130/FIN A 
FS 1-77 ............................  130/FIN A 
FS 1-78 ............................  130/FIN A 
FS 2-1 ..............................  130/FIN A 
FS 2-2 ..............................  130/FIN A 
FS 2-3 ..............................  130/FIN A 
FS 2-4 ..............................  130/FIN A 
FS 2-5 ..............................  130/FIN A 
FS 2-6 ..............................  130/FIN A 

 * – Omit from flight book 
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FS 2-7 .............................  130/FIN A 
FS 2-8 .............................  130/FIN A 
FS 2-9 .............................  130/FIN A 
FS 2-10 ...........................  130/FIN A 
FS 2-11 ...........................  130/FIN A 
FS 2-12 ........................... ⊗ 130/FIN A 
FS 2-13 ........................... ⊗ 130/FIN A 
FS 2-14 ........................... ⊗ 130/FIN A 
FS 2-15 ...........................  130/FIN A 
FS 2-16 ...........................  130/FIN A 
FS 2-17 ...........................  130/FIN A 
FS 2-18 ........................... ⊗ 130/FIN A 
FS 2-19 ...........................  130/FIN A 
FS 2-20 ...........................  130/FIN A 
FS 2-21 ...........................  130/FIN A 
FS 2-22 ........................... ⊗ 130/FIN A 
FS 2-23 ...........................  130/FIN A 
FS 2-24 ...........................  130/FIN A 
FS 2-25 ...........................  130/FIN A 
FS 2-26 ...........................  130/FIN A 
FS 2-27 ...........................  130/FIN A 
FS 2-28 ...........................  130/FIN A 
FS 2-29 ...........................  130/FIN A 
FS 2-30 ...........................  130/FIN A 
FS 3-1 .............................  130/FIN A 
FS 3-2 .............................  130/FIN A 
FS CC 3-3 .......................  130/FIN A 
FS CC 3-4 .......................  130/FIN A 
FS CC 3-5 .......................  130/FIN A 
FS CC 3-6 ....................... ⊗ 130/FIN A 
FS CC 3-7 .......................  130/FIN A 
FS CC 3-8 .......................  130/FIN A 
FS CC 3-9 .......................  130/FIN A 
FS CC 3-10 .....................  130/FIN A 
FS CC 3-11 .....................  130/FIN A 
FS CC 3-12 .....................  130/FIN A 
FS CC 3-13 ..................... ⊗ 130/FIN A 
FS CC 3-14 .....................  130/FIN A 
FS CC 3-15 .....................  130/FIN A 
FS CC 3-16 ..................... ⊗ 130/FIN A 
FS CC 3-17 ..................... ⊗ 130/FIN A 
FS CC 3-18 ..................... ⊗ 130/FIN A 
FS CC 3-19 ..................... ⊗ 130/FIN A 
FS CC 3-20 ..................... ⊗ 130/FIN A 
FS CC 3-21 .....................  130/FIN A 
FS CC 3-22 ..................... ⊗ 130/FIN A 
FS CC 3-23 ..................... ⊗ 130/FIN A 
FS CC 3-24 .....................  130/FIN A 
FS CC 3-25 .....................  130/FIN A 
FS CC 3-26 ..................... ⊗ 130/FIN A 
FS CC 3-27 .....................  130/FIN A 
FS CC 3-28 .....................  130/FIN A 
FS 3-29 (4 pgs) ............... Δ 130/FIN A 
FS 3-30 (4 pgs) ............... Δ 130/FIN A 
4-i ....................................  generic 
4-ii ...................................  generic 

4-1 ................................... † generic 
4-2 ................................... † generic 
4-3 ................................... † generic 
4-4 ................................... † generic 
4-5 ................................... †⊗ generic 
4-6 ................................... †⊗ generic 
4-7 ................................... †⊗ generic 
4-8 ................................... † generic 
4-9 ................................... † generic 
4-10 ................................. † generic 
4-11 ................................. † generic 
4-12 ................................. † generic 
4-13 ................................. † generic 
4-14 ................................. † generic 
4-15 ................................. † generic 
4-16 ................................. † generic 
4-17 ................................. † generic 
4-18 ................................. † generic 
4-19 ................................. † generic 
4-20 ................................. † generic 
4-21 ................................. † generic 
4-22 ................................. †⊗ generic 
4-23 ................................. †⊗ generic 
4-24 ................................. †⊗ generic 
4-25 ................................. †⊗ generic 
4-26 ................................. †⊗ generic 
4-27 ................................. †⊗ generic 
4-28 ................................. †⊗ generic 
4-29 ................................. † generic 
4-30 ................................. † generic 
4-31 ................................. † generic 
4-32 ................................. † generic 
4-33 ................................. † generic 
4-34 ................................. † generic 
4-35 ................................. † generic 
4-36 ................................. † generic 
4-37 ................................. † generic 
4-38 ................................. † generic 
5-1 ................................... † generic 
5-2 ................................... † generic 
5-3 ................................... † generic 
5-4 ................................... † generic 
5-5 ................................... † generic 
5-6 ................................... † generic 
5-7 ................................... †⊗ generic 
5-8 ................................... †⊗ generic 
5-9 ................................... †⊗ generic 
5-10 ................................. † generic 
5-11 ................................. † generic 
5-12 ................................. † generic 
5-13 ................................. †⊗ generic 
5-14 ................................. †⊗ generic 
5-15 ................................. †⊗ generic 
5-16 ................................. †⊗generic  
5-17 ................................. † generic 
5-18 ................................. † generic 
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5-19 ................................. † generic 
5-20 ................................. † generic 
5-21 ................................. † generic 
5-22 ................................. † generic 
5-23 ................................. † generic 
5-24 ................................. † generic 
6-1 ................................... † generic 
6-2 ................................... † generic 
6-3 ................................... † generic 
6-4 ................................... † generic 
6-5 ................................... †⊗ generic 
6-6 ................................... †⊗ generic 
6-7 ................................... † generic 
6-8 ................................... † generic 
6-9 ................................... † generic 
6-10 ................................. † generic 
6-11 ................................. † generic 
6-12 ................................. † generic 
6-13 ................................. † generic 
6-14 ................................. † generic 
6-15 ................................. † generic 
6-16 ................................. † generic 
6-17 ................................. † generic 
6-18 ................................. † generic 
7-1 ................................... † generic 
7-2 ................................... † generic 
7-3 ................................... † generic 
7-4 ................................... † generic 
7-5 ................................... † generic 
7-6 ................................... † generic 
7-7 ................................... †⊗ generic 
7-8 ................................... † generic 
7-9 ................................... † generic 
7-10 ................................. † generic 
7-11 ................................. † generic 
7-12 ................................. † generic 
7-13 ................................. † generic 
7-14 ................................. † generic 
7-15 ................................. †⊗ generic 
7-16 ................................. † generic 
7-17 ................................. † generic 
7-18 ................................. † generic 
7-18a ............................... † generic 
7-18b ............................... † generic 
7-19 ................................. † generic 
7-20 ................................. † generic 
7-21 ................................. † generic 
7-22 ................................. † generic 
7-23 ................................. †⊗ generic 
7-24 ................................. †⊗ generic 
8-1 ................................... † generic 
8-2 ................................... † generic 
8-3 ................................... † generic 
8-4 ................................... † generic 
8-5 ................................... † generic 
8-6 ................................... † generic 

9-1 ................................... † generic 
9-2 ................................... † generic 
9-3 ................................... †⊗ generic 
9-4 ................................... †⊗ generic 
10-1 ................................. † generic 
10-2 ................................. † generic 
10-3 ................................. † generic 
10-4 ................................. † generic 
10-5 ................................. † generic 
10-6 ................................. †⊗ generic 
10-7 ................................. † generic 
10-8 ................................. † generic 
10-9 ................................. † generic 
10-10 ............................... † generic 
10-11 ............................... † generic 
10-12 ............................... † generic 
10-13 ............................... † generic 
10-14 ............................... † generic 
10-15 ............................... † generic 
10-16 ............................... † generic 
10-17 ............................... † generic 
10-18 ............................... † generic 
10-19 ............................... † generic 
10-20 ............................... † generic 
10-21 ............................... † generic 
10-22 ............................... † generic 
10-23 ............................... † generic 
10-24 ............................... † generic 
10-25 ............................... † generic 
10-26 ............................... † generic 
11-1 ................................. † generic 
11-2 ................................. † generic 
11-3 ................................. † generic 
11-4 ................................. † generic 
11-5 ................................. † generic 
11-6 ................................. † generic 
11-7 ................................. † generic 
11-8 ................................. † generic 
11-9 ................................. † generic 
11-10 ............................... † generic 
11-11 ............................... †⊗ generic 
11-12 ............................... † generic 
12-1 ................................. † generic 
12-2 ................................. † generic 
12-3 ................................. † generic 
12-4 ................................. † generic 
12-5 ................................. † generic 
12-6 ................................. † generic 
12-7 ................................. † generic 
12-8 ................................. † generic 
12-9 ................................. † generic 
12-10 ............................... † generic 
12-11 ............................... † generic 
12-12 ............................... † generic 
12-12a ............................. † generic 
12-12b ............................. † generic 
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12-13 ............................... † generic 
12-14 ............................... †⊗ generic 
12-15 ............................... † generic 
12-16 ............................... † generic 
12-17 ............................... † generic 
12-18 ............................... † generic 
12-19 ............................... † generic 
12-20 ............................... † generic 
13-1 ................................. † generic 
13-2 ................................. † generic 
13-3 ................................. † generic 
13-4 ................................. †⊗ generic 
13-5 ................................. †⊗ generic 
13-6 ................................. †⊗ generic 
13-7 ................................. †⊗ generic 
13-8 ................................. †⊗ generic 
13-9 ................................. † generic 
13-10 ............................... † generic 
13-11 ............................... † generic 
13-12 ............................... † generic 
14-1 ................................. † generic 
14-2 ................................. † generic 
14-3 ................................. † generic 
14-4 ................................. † generic 
15-1 ................................. † generic 
15-2 ................................. † generic 
15-3 ................................. † generic 
15-4 ................................. † generic 
15-5 ................................. † generic 
15-6 ................................. † generic 
15-7 ................................. † generic 
15-8 ................................. † generic 
15-9 ................................. † generic 
15-10 ............................... † generic 
15-11 ............................... † generic 
15-12 ............................... † generic 
15-13 ............................... † generic 
15-14 ............................... † generic 
15-15 ............................... † generic 
15-16 ............................... † generic 
16-1 ................................. † generic 
16-2 ................................. † generic 
16-3 ................................. † generic 
16-4 ................................. † generic 
16-5 ................................. † generic 
16-6 ................................. † generic 
17-1 ................................. † generic 
17-2 ................................. † generic 
18-1 ................................. † generic 
18-2 ................................. † generic 
18-3 ................................. † generic 
18-4 ................................. † generic 
18-5 ................................. † generic 
18-6 ................................. † generic 
19-1 ................................. † generic 
19-2 ................................. † generic 

19-3 ................................. † generic 
19-4 ................................. † generic 
19-5 ................................. † generic 
19-6 ................................. † generic 
19-7 ................................. † generic 
19-8 ................................. † generic 
19-9 ................................. † generic 
19-10 ............................... † generic 
19-11 ............................... † generic 
19-12 ............................... † generic 
20-1 ................................. † generic 
20-2 ................................. † generic 
20-3 ................................. † generic 
20-4 ................................. † generic 
20-5 ................................. † generic 
20-6 ................................. † generic 
20-7 ................................. † generic 
20-8 ................................. † generic 
20-9 ................................. † generic 
20-10 ............................... † generic 
20-11 ............................... † generic 
20-12 ............................... † generic 
20-13 ............................... † generic 
20-14 ............................... † generic 
20-15 ............................... †⊗ generic 
20-16 ............................... † generic 
20-17 ............................... † generic 
20-18 ............................... †⊗ generic 
20-19 ............................... † generic 
20-20 ............................... † generic 
20-21 ............................... † generic 
20-22 ............................... † generic 
21-1 ................................. † generic 
21-2 ................................. † generic 
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PHOTO/TV CUE CARDS 

 Title Ref. Page Card No. 
TV 

(Front) ...................................................................... FS CC 3-3 P/TV-1a/130/O/A 
(Back) ...................................................................... FS CC 3-4 P/TV-1b/130/O/A 

 
ANALOG PLAYBACK 

(Front) ...................................................................... FS CC 3-5 P/TV-2a/130/O/B 
(Back) ...................................................................... FS CC 3-6 P/TV-2b/130/O/B 

 
ET PHOTO 

(Front) ...................................................................... FS CC 3-7 P/TV-3a/130/O/B 
(Back)  ..................................................................... FS CC 3-7 P/TV-3b/130/O/B 

 
MEDIA ALLOCATIONS 

(Front) ...................................................................... FS CC 3-8 P/TV-4a/130/O/B 
(Back) ...................................................................... FS CC 3-9 P/TV-4b/130/O/A 

 
WVS 

(Front) ...................................................................... FS CC 3-10 P/TV-5a/130/O/A 
(Back) ...................................................................... FS CC 3-11 P/TV-5b/130/O/A 

 
PLBD VTR RECORDING 

(Front) ...................................................................... FS CC 3-12 P/TV-6a/130/O/A 
(Back) ...................................................................... FS CC 3-13 P/TV-6b/130/O/A 

 
LDRI/ITVC 

(Front) ...................................................................... FS CC 3-14 P/TV-7a/130/O/C 
(Back) ...................................................................... FS CC 3-15 P/TV-7b/130/O/A 

 
LCS 

(Front) ...................................................................... FS CC 3-16 P/TV-8a/130/O/B 
(Back) ...................................................................... FS CC 3-17 P/TV-8b/130/O/A 

 
IDC 

(Front) ...................................................................... FS CC 3-18 P/TV-9a/130/O/B 
(Back) ...................................................................... FS CC 3-19 P/TV-9b/130/O/A 

 
VIDEO SETUP 

(Front) .......................................................................... FS CC 3-20 P/TV-10a/130/O/C 
(Back) ........................................................................... FS CC 3-21 P/TV-10b/130/O/A 

 
D2Xs SETUP 

(Front) .......................................................................... FS CC 3-22 P/TV-11a/130/O/B 
(Back) ........................................................................... FS CC 3-23 P/TV-11b/130/O/A 

 
LDRI/ITVC A7 PLACARD 

(Front) .......................................................................... FS CC 3-24 P/TV-12a/130/O/A 
(Back) ........................................................................... FS CC 3-24 P/TV-12b/130/O/A 

 
DIGITAL PLAYBACK 

(Front) .......................................................................... FS CC 3-25 P/TV-13a/130/O/C 
(Back) ...................................................................... FS CC 3-26 P/TV-13b/130/O/B 

 
G1 SETUP CUE CARD 

(Front) .......................................................................... FS CC 3-27 P/TV-17a/130/O/A 
(Back) ........................................................................... FS CC 3-28 P/TV-17b/130/O/A 
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P/TV01   VIDEO SETUP 

H/W SUMMARY 

jsc48038_130_001r6.cvx

VPU Patch Cable

A31p Video
Adapter

RPOP A31p

A31p Video
Adapter

WLES A31p

SSV BNC to
BNC Cable

SSV to PDIP/CIP Cable

Bal/Unbal

Video

Video A (PAYLOAD)

SSV DC Pwr Cable

Pwr

PAYLOAD DATA INTERFACE PANEL 2 (L11)

CABIN P/L
J105 J107J101 J103DC1 DC2

(Not
Used)

Video Spare 1
(Gnd cntl)

SSV Compression Encoder BoxSSVTCS

Digital CC Vid/Pwr Cable (15 ft) VideoPwr

Digital CC Vid/Pwr Cable (15 ft) Pwr

J2
VIDEO
J4

J6
MD

AVIU

J1
75
J5

LO
J3
J7

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

DTV MON 2 Cable

To
MON 2

C IN

To
CCTV
P/L 3

SEC
C/L

LDRI/
ITVC

VIDEO PROCESSING UNIT

3

ON

OFFCB1

RSC VIDEO

J101 J103 J105 J107

OPP

R12

RSC Video Cable

WVS 1 TV Pwr Cable (20 ft)

WVS 2 TV Pwr Cable (20 ft)

MON 1 TV Pwr
Cable (10 ft)

PCMCIA to
WIB-Remote
Cable (6 ft)

RS-422 PCMCIA
Card/Cable Assy

ASC/ENT/FD TV
Pwr Cable (10 ft)

WLES
A31p

Pwr,Sync MD TV Pwr Cable (10 ft) Video

A31p Video
Adapter

LCS Video Cable

Balanced Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable

Video

CDR
CCU

BPSMU to CCU
Adapter Cable

Video

*

OPP-LCC
Cable

MON 2 VPU Cable

MHA MS
CCU

PLAY
WVS 2

ATU RecorderREC

PLAY

REC

Comm Cable
(4 ft)

Comm Cable
(4 ft)

WVS 1
ATU Recorder

MON 1 AVIU Cable

Balanced Video Cable

RWS #1
Drag-Thru

Cable

BNC Straight
Adapter

RWS #2
Drag-Thru

Cable

RWS #2
Drag-Thru

Cable

RWS #1 Drag-Thru Cable

RWS #1
Drag-Thru

Cable

To
CCTV
P/L 2

Wide
Conversion

Lens

Multiuse
Arm

FD CC

RCA-BNC
Adapter

V2

Wide
Conversion

Lens

Multiuse
Arm

MD CC

RCA-BNC
Adapter

V2

MON 1
Repeater Cable

RCA Barrel
Adapter

MON 1
Repeater Cable MENU SOURCE - DNLK

MENU SOURCE - C
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 P/TV01   VIDEO SETUP (Continued) 

SETUP 

NOTE 
Steps 1-7 minimum rqmt for FD2 OBSS RCC Inspection 

 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 

 
 2. Perform DTV Setup 

 
O19 TV PWR – OFF 

 
L10:A1 Unstow AVIU and disconnect following cables: 

ASC/ENT/FD TV Pwr Cable from J2 
ASC/HUD Mini-Cam Cable from J5 
Mini-Cam BNC Video Cable from J1 

Temp stow AVIU and attached Digital CC Vid/Pwr Cable for FD CC 
F1 Disconnect Mini-Cam; stow body, Brkt, 3.5mm Lens in A17/DTV Bag 
A15 Connect DTV Audio Cable to PS CCU 

Config DTV H/W per H/W SUMMARY, FS 1-4 
 

Config Panels 
L10 (MUX) √VTR/CC PWR – on (LED on) 

If dnlk: 
MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
 

L10 (VIP) √ATU – REC 
√CCTV VIDEO IN – J3 
√PWR – on (LED on) 

 
L10 (VTR) √ON/STANDBY LED – green 

√Switches set to White Dot (seven) 
√COUNTER SELECT – COUNTER (TC) 

 
Config Video 

MON 1 SOURCE – DNLK 
MON 2 SOURCE – C 
L9 Config PS ATU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 3. Perform MON 1,2 V10 Setup 
 

MA16J Remove MON 1,2 Desk Assy Hardware from Stow-n-Go CTB 
 

O19 TV PWR – OFF 
 

Config MON 1,2 V10s and Cables per H/W SUMMARY, FS 1-4 
Connect: 

Retrieve MON 1 V10 from MS1 Bag 
Retrieve MON 2 V10 from Seat 6 FDF Bag 
Eject, mark, and write-protect tapes 
Stow tapes for playback 
MON 1,2 Digital CC Vid/Pwr Cables to MON 1,2 V10s 
MON 1,2 AVIU-CC Video Cables to MON 1,2 V10s 
Multiuse Brkt to desk 
RWS #1 Drag-Thru Cable to MON 1 AVIU J6 
MON 1 AVIU Cable to MON 1 AVIU J4 
MON 2 Balanced Video Cable to MON 2 AVIU J4 
MON 1,2 TV PWR Cable to MON 1,2 AVIU J2 
MON 1 Repeater Cable string to MON 1 AVIU J5 and A31p Vid In port 
Multiuse Brkt to wall 

 
AVIU (MON 1,2) √SYNC/VIDEO – VIDEO 

√HI-Z/75 – 75 
√PWR SELECT – LO 

 
O19 TV PWR – ON 
V10 (MON 1,2) PWR – ON 

DISPLAY pb – toggle to display tape counter 
√Tape installed 

R12 (VPU) VPU PWR – ON (LED on) 
 

 4. √RSC Video Cable connected between R12/OPP-RSC Video (J105) and R12/VPU-CCTV PL3 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 5. Perform Camcorder Setup for FD and MD per H/W SUMMARY, FS 1-4, as reqd 
 

O19,MO58F TV PWR – OFF 
Disconnect ASC Win 4 Mini-Cam Cable from MO58F J3 pigmy port 
Retrieve: 

ASC/ENT/FD AVIU from temp stow for FD CC 
MD AVIU from Stow-n-Go CTB 

 
AVIU (FD) SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
O19 TV PWR – ON 

 
G1 Install Wide Conversion lens 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
A17 Unstow MD CC 

Repeat step 5 for CC config  
 

 6. Perform LCS Cable Connections per H/W SUMMARY, FS 1-4, as reqd 
 

MO58F TV PWR – OFF 
 

 If MD Camcorder not set up, unstow MD AVIU from Stow-n-Go CTB 
 

Connect MD TV Pwr Cable to MD AVIU J2 
 Connect end of LCS Video Cable to MD AVIU J1 
AVIU (MD) HI-Z/75 – 75 
Flt Deck Connect other end of LCS Video Cable (A31p Video Adapter) to A31p Video Out port via PGSC Usage Chart 

Connect OPP-LCC Cable to A31p RJ45 Ethernet port via PGSC Usage Chart 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 7. Perform SSV Setup 
 

MF71O Unstow: 
SSV Compression Encoder Box 
SSV BNC-BNC Cable 
SSV to PDIP/CIP Cable 
PGSC Pwr Cable 
Bal/Unbal Xfmr 

 
Config SSV H/W per H/W SUMMARY, FS 1-4 

 
NOTE 

SSV input video controlled by MCC
 

L12 (SSP 2) √PDIP 2 PWR 1 (CB3) – cl 
L11 (PDIP 2) DC PWR 1 – ON 

 
Config SSV settings 

SSV IN SEL – NTSC 
Mode – 3 
OUTRATE – 4 
SSV Pwr – on 
√Pwr LED illum 
√ENC DATA LED flickering 
√FRM DATA LED flickering 
√FILL FRM pulsing 

 
Inform MCC when SSV SETUP complete 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup 

 a. Activate WVS System 
 

A7  WIRELESS VID HTR – ON 
WIRELESS VID PWR – ON 

 
MO58F  TV PWR – OFF 

 
MA16J b. Remove WVS Hardware from Stow-n-Go CTB 

 
Config WVS 1,2 V10s and Cables per H/W SUMMARY, FS 1-4 
Connect: 

WVS 1,2 Digital CC Vid/Pwr Cables to WVS 1,2 V10s 
WVS 1,2 AVIU-CC Vid Cables to WVS 1,2 V10s 
Multiuse Brkt to desk 
Pre-routed WVS 1,2 Balanced Video Cables from R12/VPU XCVR 1,2 BAL to WVS 1,2 AVIU J4 
Pre-routed WVS TV Pwr Cables to WVS 1,2 AVIU J2 
Balanced Video Cables stowed on WVS Stow-n-Go desk to WVS 1,2 AVIU J6 
ATU Recorder Cables to left (white) port per H/W SUMMARY, FS 1-4 
Multiuse Brkt to wall 
PCMCIA-to-WIB Remote Cable to R12/WIB J701 
RS-422 PCMCIA Card/Cable Assy and PCMCIA-to-WIB Remote Cable to bottom PCMCIA slot on A31p per  
PGSC Usage Chart 

 
AVIU (WVS 1,2)  √SYNC/VIDEO – VIDEO 

√HI-Z/75 – 75 
√PWR SELECT – LO 

 
V10 (two) 

MO58F  TV PWR – ON 
V10 (WVS 1,2)  PWR – ON 

√Tape installed 
√WVS Test Pattern displayed (color bars w/“No WVS Video”) 

PWR – OFF 
 

R10  Config MS ATU/CCU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup (Continued) 
 

 c. WVS PGSC Prep 
 

PGSC Pwrup and Application Opening 
PGSC  √Pwr – ON 

Sel Shuttle Apps icon 
Sel WVS icon 

 
Sel ‘No’ at ‘Restore To Previous Settings:’ window 

 
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card in bottom PCMCIA slot 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear 
 

Application Setup 
If ‘Static XCVR’(‘Bad Camera ID’,‘Temp Alert’,‘Temp Caution’) alert msg: 

Perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS) 
If ‘Static RF Camera’ alert msg: 

Disregard 
Sel ‘File’ → ‘Assign Camera ID’ 
Verify following: 

 
Camr Address S/N In Use Label 

16 1010 1 EV1
18 1007 1 EV2

 
If Camr IDs not correct: 

Sel ‘Delete Entry’ until all deleted 
Perform CAMR ID ASSIGNMENT (Cue Card, WVS) as reqd 

When complete, sel ‘OK’ 
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P/TV01   VIDEO SETUP (Concluded) 

SETUP (Concluded) 

 8. Perform WVS Setup (Concluded) 
 

 c. WVS PGSC Prep (Concluded) 

Application Setup (Concluded) 

Sel ‘File’ → ‘Advanced Controls’ 
On XVCR tab: 
√IF – selected 
√Other options not selected 

Sel RF Camera tab: 
√Power Selections – selected 
√Automatic Gain Control – selected 
√S-Band Level – selected 
√Other options not selected 

When complete, sel ‘OK’ 
 

 d. PWRDN 

Sel ‘File’ → ‘Exit’ 
A7  WIRELESS VID PWR – OFF 

WIRELESS VID HTR – OFF 
 

MF71O 9. Unstow,set up BPSMU w/BPSMU to CCU Adapter Cable at CDR CCU 
Connect BPSMU Batt 
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P/TV02   DOCK 

H/W SUMMARY 

Digital CC Vid/Pwr Cable (15 ft) VideoPwr

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

jsc48038_130_002r5.cvx

SEC
C/L

Sec
C/L

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

ASC/ENT/FD TV
Pwr Cable

(10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIU

MON 2 VPU Cable

DTV Audio Cable

DTV MON 2 Cable

To
MON 2

C IN

WLES A31p

MON 1
Repeater Cable

A31p Video
Adapter

Wide
Conversion

Lens

Multiuse
Arm

FD CC

RCA-BNC
Adapter

V2

RCA Barrel
Adapter

MON 1
Repeater Cable MENU SOURCE - PNL

MENU SOURCE - PNL
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P/TV02   DOCK (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video,still photos of ISS rndz,docking 
 

SETUP 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform D2Xs PROGRAM w/FLASH for in-cabin imagery  

Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –  
√Exp Comp – 0 EV 

Tilt – 45° (Direct)  

 TTL BL
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P/TV02   DOCK (Continued) 

SETUP (Continued) 

 3. Perform D2Xs MANUAL for docking/external imagery 
 

Remove ovhd window shields 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
Lens – 400mm(80-200mm) 
If 400mm: 

Focus Limit – ∞-6m 
Lens Focus Mode – A 

If 80-200mm: 
Focus Limit – full 
Lens Focus Mode – M/A 

Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – M 

SS – 500 
f/stop – 8 

Meter – Matrix (    ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 
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P/TV02   DOCK (Continued) 

SETUP (Continued) 

 4. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19,MO58F √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – SEC C/L 
√SEC C/L Cap installed 

 
V10 PWR – ON 
(MON 1,2) √Tape installed 

DISPLAY pb – Toggle to display tape counter 
 

For in-cabin views: 
G1 √Wide Conversion lens installed 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
√Tape installed 

Open LCD 
√“green”  •|| displayed 

Install Audio Muting Plug (optional) 
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P/TV02   DOCK (Continued) 

SETUP (Concluded) 

 4. Perform Hardware Verification for V10s, FD CC, DTV (Concluded) 
 

For sunlit ISS views: 
Remove Wide Conversion Lens 
Install fresh Batt as reqd 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M  
√Tape installed 

Open LCD 
√“green”  •|| displayed 

SS – 1/500 
√GAIN – 0dB 

f/stop – F8.0 
√FOCUS – M ∞- (adjust as reqd) 

Install Audio Muting Plug (optional) 
 

MON 1,2 SOURCE – PNL 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
 

A31p √MON 1 Repeater Cable connected to WLES A31p video in port 
Double click ‘Shuttle Apps’ > ‘NASA Video Overlay’ 
√‘NASA Video Overlay’ window displayed 
Sel ‘Full Screen’ 
Press ‘ESC’ or ‘W’ key to minimize display as reqd 
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P/TV02   DOCK (Continued) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk
 1. 

 
20A-9 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – OFF 

As desired G1 
Tape installed 

LIVE
(If avail) 

Plan for end of day crew 
choice video,DCS 

 2. 
 

20A-3 
 

20A-10 

Rendezvous D2Xs
400mm(80-200mm) 
Flash ON/OFF – OFF 
 

A(B,C,D), ELB G1 
As desired 

Map ISS surfaces w/30% 
overlap 

Rcd C/L Camr video thru hard 
dock on DTV 

• Map ISS surface 
• Closeup 
• Damage 
• Deterioration 

Approach 
• PMA-2 Docking Target 

Alignment 
• PMA-2 Mating Surfaces
• PMA-2 Hemispherical 

and Planar 
Retroreflectors 

• MISSE 
• SOLAR 

 



 FS 1-20 P/TV/130/FIN A 

P/TV02   DOCK (Continued) 

OPS (Continued) 

APPROACH/DOCKING RQMTS

PMA2 APDS Area

Mapping of ISS Module Surfaces

C/L Camr

Camr A(D)

30 ft200 ft500 ft D
O
C
K
E
D

O
P
S

400 ft

MON 1
DTV (RCD)

D2Xs Camr
w/400mm Lens

jsc48038_130_003r2.cvx

Camr C(B)

MON 2

PAO Views D2Xs Camr
w/12-24mm Lens

170 ft
~7 ft
Dock

Docking View

Range
Ruler

D2Xs Camr
w/80-200mm Lens
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P/TV02   DOCK (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
PWR – OFF 
√Flash ON/OFF – ON 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED on) 

A7 VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L camr, Harness Assy, Bridge 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 
 3. G1 

PWR dial – “green”  
Install Wide Conversion Lens 
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P/TV03   UNDOCK 

H/W SUMMARY 

Digital CC Vid/Pwr Cable (15 ft) VideoPwr

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

jsc48038_130_002r5.cvx

SEC
C/L

Sec
C/L

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

ASC/ENT/FD TV
Pwr Cable

(10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIU

MON 2 VPU Cable

DTV Audio Cable

DTV MON 2 Cable

To
MON 2

C IN

WLES A31p

MON 1
Repeater Cable

A31p Video
Adapter

Wide
Conversion

Lens

Multiuse
Arm

FD CC

RCA-BNC
Adapter

V2

RCA Barrel
Adapter

MON 1
Repeater Cable MENU SOURCE - PNL

MENU SOURCE - PNL
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P/TV03   UNDOCK (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video,still photos of ISS undocking,flyaround 
 

SETUP 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform D2Xs PROGRAM w/FLASH for in-cabin imagery  

Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –   
√Exp Comp – 0 EV 

Tilt – 45° (Direct)  

 TTL BL
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P/TV03   UNDOCK (Continued) 

SETUP (Continued) 

 3. Perform D2Xs MANUAL for undocking/external imagery  
Remove ovhd window shields 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
Lens – 400mm(80-200mm) 
If 400mm: 

Focus Limit – ∞-6m 
Lens Focus Mode – A 

If 80-200mm: 
Focus Limit – full 
Lens Focus Mode – M/A 

Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – M 

SS – 500 
f/stop – 8 

Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
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P/TV03   UNDOCK (Continued) 

SETUP (Continued) 
 4. Perform Hardware Verification for V10s, FD CC, DTV 

 
O19 √TV PWR – ON 

 
R12 (VPU) √VPU PWR – ON (LED on) 

√Green Jumper – SEC C/L 
√SEC C/L Cap installed 

 
V10 PWR  – ON 
 (MON 1,2) √Tape installed 

DISPLAY pb – Toggle to display tape counter 
 

For in-cabin views: 
G1 √Wide Conversion lens installed 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
√Tape installed 

Open LCD 
√“green”  •|| all displayed 

Install Audio Muting Plug (optional) 
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P/TV03   UNDOCK (Continued) 

SETUP (Concluded) 
 4. Perform Hardware Verification for V10s, FD CC, DTV (Concluded) 

 
For sunlit ISS views: 

Remove Wide Conversion Lens 
Install fresh Batt as reqd 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M 
√Tape installed 

Open LCD 
√“green”  •|| displayed 

SS – 1/500 
√GAIN – 0dB 

f/stop – F8.0 
√FOCUS – M ∞- (adjust as reqd) 

Install Audio Muting Plug (optional) 
 

MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
 

A31p Double click ‘Shuttle Apps’ > ‘NASA Video Overlay’ 
 √‘NASA Video Overlay’ window displayed 

Sel ‘Full Screen’ 
Press ‘ESC’ or ‘W’ key to minimize display as reqd 

 



 FS 1-29 P/TV/130/FIN A 

P/TV03   UNDOCK (Continued) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk
 1. 

 
20A-9 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – OFF 

As desired G1 
Tape installed 

LIVE
(If avail) 

Plan for end of day crew 
choice video,DCS 

 2. 
 

20A-5 

Undock D2Xs
80-200mm(400mm) 
Flash ON/OFF – OFF 
 

A(D)
 

G1 
As desired 

Map ISS surfaces w/30% 
overlap • PMA-2 Mating Surfaces

• PMA-2 Hemispherical 
and Retro Planar 
Reflectors 

C/L
Docking tgt and 

PAO view 

LIVE
(If avail) 

• MISSE 

• SOLAR 

 3. 
 

20A-2 

Flyaround D2Xs
80-200mm(400mm) 
Flash ON/OFF – OFF 
 

A(D)
 

G1 
 

IVA stills returned post flight
External video returned 

post flight • Surfaces 

• Solar panels 

• Handrails 

• SM thrusters (Zenith side 
near aft end) 

• Trusses including 
radiators, baseplates, 
and saws (especially 
in/outboard SABB 
insulation degradation) 
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P/TV03   UNDOCK (Continued) 

OPS (Continued) 

UNDOCKING/FLYAROUND RQMTS

PMA2 APDS Area

Mapping of ISS Module Surfaces

C/L Camr

Camr C

Camr A(D) (flyaround at 400 ft)

400 ft200 ft30 ftD
O
C
K
E
D

O
P
S

100 ft

D2Xs Camr
w/80-200mm Lens

MON 1

D2Xs Camr
w/400mm Lens

DTV

(At 400 ft only)

jsc48038_130_004r2.cvx

Camr A(D)MON 2

PAO ViewsD2Xs Camr
w/12-24mm Lens
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P/TV03   UNDOCK (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
PWR – OFF 
√Flash ON/OFF – ON 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED ON) 

A7U VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L Camr, Harness Assy 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 
 3. G1 

PWR dial – “green”  
Install Wide Conversion Lens 
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P/TV04 
INGR/EGR         
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P/TV04   INGRESS/EGRESS 

H/W SUMMARY 

INGRESS TV CONFIG 

jsc48038_130_005r4.cvx

MD G1 Wide
Conversion

Lens

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS
CCTV PL3

Batt

Batt Worklight

 

P/TV04 
INGR/EGR         
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P/TV04   INGRESS/EGRESS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for documenting ISS ingress/egress w/video and still photos 
 

SETUP 
 1. Config ISS Video 

 
 Perform ACTIVATION (Cue Card, TV) for DNLK OPS of ISS signal as reqd 
R12 (VPU) Green Jumper – ISS 

√VPU PWR – ON 
 

A7 VID OUT DNLK pb – push 
VID IN PL2(VPU) pb – push 

 
 2. Perform Ingress Camcorder Setup 

 
Obtain two Batts, one for CC and one spare 
Install Batt 

G1 √Wide Conversion lens installed 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 

 
CAUTION 

Due to temp constraints, worklights at full 
pwr for 60 min; 90% pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light on CC 
PWR – as reqd 
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P/TV04   INGRESS/EGRESS (Continued) 

SETUP (Concluded) 

 3. Perform D2Xs PROGRAM w/FLASH 
 

Lens – 12-24mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

 
Exp Comp (       ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –   
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

 TTL BL



 FS 1-37 P/TV/130/FIN A 

P/TV04   INGRESS/EGRESS (Concluded) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk
 1. Hatch Opening, Ingress 

Hatch Close, Egress 
D2Xs
12-24mm  

G1 
 

LIVE
(if avail) 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 
 1. D2Xs 

Pwr – OFF 
 

 2. TV System 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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        P/TV05 
ISS INT OPS 



 FS 1-40 P/TV/130/FIN A 

P/TV05   ISS INTERNAL OPS 

H/W SUMMARY 

A31p Video
Adapter

A31p Video
Adapter

RWS 1,2
Drag-Thru Cables

35 ft BPSMU
Audio #2 Cable

BPSMUN/A

42 ft BPSMU
Audio #2 Cable

jsc48038_130_006ar6.cvx

Shuttle Half

Station Half

BPSMU
1

BPSMU
2

Video
1

Video
2

Drag-Through QD Box

BPSMU
1

BPSMU
2

Video
1

Video
2

RWS 1,2
Drag-Thru

Cables

To Shuttle

44 ft
BPSMU
Audio #2

Cable

RWS 1,2
Drag-Thru

Cables

COLUMBUS

NODE 3

JEM

TO AIRLOCK

NODE 2

NODE 1

Shuttle
Station

Note:
Drag-thru into Node 3 as reqd.
Verify a QD is always within
2 ft. of Node1/Node 3 hatch

 

        P/TV05 
ISS INT OPS 



 FS 1-41 P/TV/130/FIN A 

P/TV05   ISS INTERNAL OPS (Continued) 

H/W SUMMARY (Concluded)  

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS
CCTVPL3

jsc48038_130_006br5.cvx

CDR
CCU

BPSMU to CCU
Adapter Cable

L10

To Station
and

Drag-Through QD Box

L10

MON 1
AVIU

J6

RWS 2
Drag-Thru

Cable

RWS 1
Drag-Thru

Cable

RWS 1,2
Drag-Thru

Cables

BPSMU/ODS
Adapter

N/A

22 ft BPSMU 2
Audio Cable

RWS 1,2
Drag-Thru

Cables

BPSMU

Temp stow
BPSMU

NOTE: For
contingency
use

4 ft BPSMU 2
Audio Cable

RWS 2
Drag-Thru

Cable

N/A

 



 FS 1-42 P/TV/130/FIN A 

P/TV05   ISS INTERNAL OPS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for setup, documenting ISS internal ops (surveys, PAO events, logistics, transfers, closeouts)  
w/video,still photos  

SETUP 

WARNING 
Locate QDs at hatches for ease in locating,disconnecting during hatch closure.  
Route,restrain cables to prevent loose cable lengths which could entrap crew 

 
 1. Config H/W per H/W SUMMARY, FS 1-40 and FS 1-41  

Prior to Docking 
Config RWS Vid Cables: 

MON 1,2 √RWS 1 Drag-Thru Cable connected to MON 1 AVIU J6 
(Stow-n-Go) 

L10:A1 √RWS 2 Drag-Thru Cable connected to DTV VTR OUT connector 
TBD Retrieve second BPSMU, connect internal battery, temp stow in ODS for contingency use  

Post Docking 
Config BPSMU and RWS Cables: 

ODS/PMA2 Connect orbiter RWS 1,2 Cables to Drag-Through QD Box 
Connect BPSMU Cable to orbiter A/L CCU 1 
Config A/L ATU per Comm Plan  

If V10: 
ISS √Pwr configured per P/TV121 DOCKED OPERATIONS, dwg USOS 120VDC –V10 VTRs (SODF: ISS PTV: SCENES) 
V10 (RWS 1,2)  PWR – ON 

If A31p w/‘NASA Video Monitor’ under Station Apps: 
√Drag-Thru Cable connected to A31p Video Adapter 

A31p √PWR – ON 
Sel ‘Station Apps : NASA Video Monitor’ 

√‘NASA Video Monitor 1.0.0.0’ window displayed 
Sel ‘Set Settings’ 

√‘Configuration’ window displayed 
Video Input Standard – NTSC 

√Video Input – ‘Composite (RCA)’ 
Video Control – press ‘Set to Defaults’ pb 
Commit Changes – ‘OK’ 
Sel ‘Full Screen’ 
Press ‘ESC’ to minimize display as reqd 
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P/TV05   ISS INTERNAL OPS (Continued) 

SETUP (Continued) 
FOR STATION PAO EVENTS 

 1. Config VPU 
 

R12 (VPU) √Green Jumper – ISS 
√VPU PWR – ON (LED on) 

 
 2. Config Shuttle Video 

 
A7 VID OUT DNLK pb – push 

VID IN PL2(VPU) pb – push 
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P/TV05   ISS INTERNAL OPS (Continued) 

SETUP (Concluded) 

STILL CAMR 

 1. Perform D2Xs PROGRAM w/FLASH 
 

Lens – 12-24mm 
√Aperture – Min, locked 

Body Focus Mode – S 
√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

 
AF Area Mode – [ [  ] ] 

√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –   
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

 TTL BL



 FS 1-45 P/TV/130/FIN A 

P/TV05   ISS INTERNAL OPS (Concluded) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk
 1. 

 
20A-9 

General ISS IVA Activity D2Xs
12-24mm 
For Crew Photo: 

Perform D2Xs CREW 
PHOTO (Cue Card, 
D2Xs SETUP) 

 
ISS G1 
 

LIVE
(if avail) 

Plan for end of day crew 
choice video, DCS 

• PAO Scenes of Interest 
• Crew Photo 
• Crew Rotation Crewmember rotation IELK 

install and Sokol suit 
checkout 

– IELK Install 
– Sokol Suit Check 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
Pwr – OFF 

 
 2. Drag-Through QD Box 

Disconnect: 
RWS Cables (two) from orbiter side Video 1,2 ports.  Stow cables on orbiter 
BPSMU Cable from orbiter side BPSMU 2 port and ODS CCU port; stow cable on orbiter 

Transfer Drag-Thru QD box and remaining attached cables to ISS 
 

 3. Temp Stowed BPSMU 
ODS Remove temp-stowed BPSMU from ODS location.  Stow in TBD 

 
 4. TV System 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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      P/TV06 
ROBOTICS   



 FS 1-48 P/TV/130/FIN A 

P/TV06   ROBOTICS OPERATIONS 

H/W SUMMARY 

Digital CC Vid/Pwr Cable (15 ft) Video

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

jsc48038_130_016r5.cvx

ISS

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

ASC/ENT/FD TV
Pwr Cable

(10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable Video

MON 1
AVIUMON 2 VPU Cable

DTV Audio Cable

DTV MON 2 Cable

To
MON 2
C IN

BNC
Straight
Adapter

To Station

Wide
Conversion

Lens

Multiuse
Arm

FD CC

RCA-BNC
Adapter

V2
A31p Video

Adapter
A31p Video

Adapter

MENU SOURCE - DNLK

MENU SOURCE - C

VPU Patch Cable

Note: Connect to bottom
“From” port as required

RPOP A31p

A31p Video
Adapter

 

      P/TV06 
ROBOTICS   



 FS 1-49 P/TV/130/FIN A 

P/TV06   ROBOTICS OPERATIONS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video of SSRMS activities 
 

SETUP 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 
 

 2. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19 √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
Green Jumper – ISS 

 
√Drag-Thru Cables configured as reqd 

 
V10 PWR – ON 
 (MON 1,2) √Tape installed 

DISPLAY pb – Toggle to display tape counter 
 

G1 √Wide Conversion lens installed 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 

 
MON 1 SOURCE – DNLK 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed  



 FS 1-50 P/TV/130/FIN A 

P/TV06   ROBOTICS OPERATIONS (Concluded) 

SETUP (Concluded) 

 3. If Video on RPOP A31p needed: 
RPOP √VPU repeater cable connected to RPOP A31p video in port 

Double click ‘Shuttle Apps’>‘NASA Video overlay’ 
√‘NASA Video overlay’ window displayed 

Sel ‘Full Screen’ 
 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk
 1. 

 
20A-9 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – OFF 

As desired G1 
Tape installed 

LIVE
(If avail) 

Plan for end of day crew choice 
video,stills 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. TV System 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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EVA     



 FS 1-52 P/TV/130/FIN A 

P/TV07   EVA 

H/W SUMMARY 

Digital CC Vid/Pwr Cable (15 ft) VideoPwr

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

MHA MS
CCU

PLAY
WVS 2

ATU RecorderREC

PLAY

REC

Comm Cable
(4 ft)

Comm Cable
(4 ft)

WVS 1
ATU Recorder

CCTV
P/L 3 P/L 2

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

To
MON 2

C IN

jsc48038_130_007r3.cvx

ISS

VIDEO PROCESSING UNIT

WVS TV Pwr Cable (20 ft)

WVS TV Pwr Cable (20 ft)

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

PCMCIA to
WIB-Remote
Cable (6 ft)

ASC/ENT/FD TV
Pwr Cable

(10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

MON
2

V10

Video

MON 2
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

R
L
V

MON 2 TV
Pwr Cable

(10 ft)

MON 2 Balanced Video Cable
Video

BNC Straight Adapters

RWS 1
VIU-CM
Cable

RWS 2
VIU-CM
Cable

RWS 2
BNC Vid

Cable

RWS 2
BNC Vid

Cable

RWS 1
BNC Vid

Cable

Video 1

Video 2

Video 1

Video 2

BNC Straight Adapters

RWS 2
BNC Vid

Cable

Drag-Through
QD BoxRWS 1

BNC Vid
Cable

RWS 1
BNC Vid

Cable

MON 2 VPU Cable

RS-422 PCMCIA
Card/Cable Assy

WLES
A31p

VPU Patch Cable

RPOP A31p

Wide
Conversion

Lens

Multiuse
Arm

FD CC

RCA-BNC
Adapter

V2

A31p Video
Adapter

A31p Video
Adapter

A31p Video
Adapter

MENU SOURCE
- DNLK

MENU SOURCE
- C

 

    P/TV07 
EVA     



 FS 1-53 P/TV/130/FIN A 

P/TV07   EVA (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for documenting ISS EVA,IVA ops w/video,still photos 
 

SETUP 
FOR ALL EVAs: 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform D2Xs PROGRAM w/FLASH  

Lens – 12-24mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –   
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 

 TTL BL
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P/TV07   EVA (Continued) 

SETUP (Continued) 

 3. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19,MO58F √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
 

V10 PWR – ON 
 (MON 1,2, √Tape installed 
 WVS 1,2) DISPLAY pb – Toggle to display tape counter 

 
G1 √Wide Conversion lens installed 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
MON 1 SOURCE – DNLK 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
 

 4. Config ISS VPU Repeater Video 
 

Config VPU Repeater Cable Assy per H/W SUMMARY, FS 1-52 
 

A31p Double-click ‘Shuttle Apps’> ‘NASA Video Overlay’ 
Sel ‘Full Screen’ 
Press ‘ESC’ to minimize display as reqd  
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P/TV07   EVA (Continued) 

SETUP (Concluded) 

 5. Config WVS and PGSC 
 

 a. Activate WVS System 
 

A7  √WIRELESS VID HTR – ON 
WIRELESS VID PWR – ON 

 
 b. WVS PGSC Prep 

 
PGSC Pwrup and Application Opening 

PGSC  Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 
Sel ‘No’ at ‘Restore To Previous Settings’ window  
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear  
NOTE 

During EVA prep, EMU TV assy will be pwrd 
 

Application Setup 
Select Page – XCVR 
Transceiver 1(2) CMD Power – ON (green CMD PWR:LVL–“ON:Min”) 
RF Camera 1 – One EVA crewmember (green “ON”) 
RF Camera 2 – Other EVA crewmember (green “ON”)  
If alert msg, perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS)  
Select Page – RF CAMERA  
Near middle of RF Camera page, sel ‘Advanced Controls’  
When Post-A/L Depress: 

For center lens on each RF Camr Assy: 
Lens Iris Cntl – op(cl) until good video on V10(MON) 



 FS 1-56 P/TV/130/FIN A 

P/TV07   EVA (Continued) 
OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk 

 1. 
 

20A-9 
 

PAO Coverage IVA D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – OFF 

As desired
WVS 

G1 
As desired 

LIVE
(if avail) 

Plan for end of day crew choice 
video,stills 

 2. 
 

20A-8 
 

20A-12 

Themal Cover Closeouts WVS  LIVE
(playback) 

• For all locations where covers 
were opened and closed 

 3. 
 

20A-15 

Node 3 EVA Outfitting EVA D2Xs
35mm (per EVA C/L) 

WVS  
• Node 3 LTA cable after 

removal from Node 1 J612 
connector, installation of cap 
to thermal bootie and tie off 
to Node 1 handrail 

• Reconnection of the A/L 
supplementary power (J612) 
connector 

• Installation Node 3 ACS non 
propulsive vent 

• Installation of Node 3 worksite 
interfaces (WIFs) (3) and 
handrails (6-14) 

• Installation of Gap spanners 
(up to 8) 

• Removal of Cupola thermal 
covers 

• Release of Cupola shutter 
launch locks 
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P/TV07   EVA (Continued) 
OPS (Continued) 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk 

 4. 
 

20A-23 

Installation and/or routing and 
connection of Node 3 Ammonia 
Jumpers and Avionics umbilicals.  
Image the following Node 3 EVA 
connections: 

EVA D2Xs
35mm (per EVA C/L) 

WVS  

• Avionics umbilicals and 
Ammonia Jumpers 

• EVA stills of the routing of the 
S0 to Node 3 Avionics 
umbilicals 

• Mating of each of the 9 
avionics umbilical 
connectors 

• Installation of the U.S. Lab to 
Node 3 Ammonia Jumpers 
(4) and thermal shrouds

• Mating of each of the 
connectors (8) with and 
without thermal shrouds

 5. 
 

20A-25 

Node 3 Installation to Node 1 Port 
CBM External video of: 

EVA D2Xs
35mm (per EVA C/L) 

WVS
PLB Camrs 

 LIVE
(if avail) 

• Inspection of the Node 3 
PCBM following the removal 
of contamination covers (8) 

• High level inspection of the 
Node 1 port CBM 

• Removal of the Node 3 from 
Orbiter payload bay and 
install on Node 1 port CBM 

External video and/or EVA stills of:
• Removal of 8 Node 3 PCBM 

contamination covers 
• Disconnection of the Node 3 

to Orbiter SPDU LTA heater 
cables (both Orbiter and 
Node 3 ends) 
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P/TV07   EVA (Concluded) 
OPS (Concluded) 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk 

 5. 
(Cont) 

 
20A-25 

 

• Open Node 1 port CBCS flap  
• Remove A/L supplementary 

power (J612) and connect 
Node 3 LTA heater cables to 
Node 1 and activate heaters 

• Install 4 Node trunnion and
1 keel pin cover 

• Install 8 on-orbit installable 
Handrails on Node 3 
(required to access 1553 
bus terminator) 

• Install 1553 bus terminator 
(P104) on Node 3 (J104) 

• Install the P1-FGB and
P2-FGB terminators and 
thermal booties 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. IVA D2Xs 
Pwr – OFF 
√Flash ON/OFF – ON 
Download images 

 
 2. TV System 

Perform PWRDN (Cue Card, WVS) 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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  P/TV08 
EXT SURVEY       
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P/TV08   EXTERNAL SURVEY 
SCENE SYNOPSIS 

Scene contains procedures for documenting STS,ISS external structures  
SETUP 

 1. D2Xs Camr Configuration for OMS Pod Survey  
Remove aft window shields 
If Sunlit OMS Pod, config D2Xs Manual Mode: 

Lens – 80-200mm at 200mm 
Focus Limit – full 
Lens Focus Mode – M/A 
Aperture – Min,locked 
Body Focus Mode – S 

√Batt installed 
Install empty Flash Card 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode– M 

SS – 1000 
f/stop – F8 

Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  

SB-800 Flash Settings 
ON/OFF pb – OFF 

~ 

  P/TV08 
EXT SURVEY       
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Continued) 

 1. D2Xs Camr Configuration for OMS Pod Survey (Concluded)  
~  
Remove aft window shields 
If Earthshine OMS Pod, config D2Xs Program Mode: 

Lens – 80-200mm at 200mm 
Focus Limit – full 
Lens Focus Mode – M/A 

√Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
Install empty Flash Card 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 

ON/OFF pb – OFF 
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Concluded) 

 2. D2Xs Camr Config for ISS Still Survey (D2Xs Shutter Priority Mode) 
 

Remove window shields 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
Lens – 28-70mm@50mm(80-200mm@200mm) 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – S 

SS – 500 
Meter – Matrix (    ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 
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P/TV08   EXTERNAL SURVEY (Continued) 
OPS 

√ Item # 
Track # 

Rqmts 
Still Imagery 

Video
Notes 

PLB CC Dnlk
 1. OMS Pod Survey D2Xs

80-200mm@200mm 

 

Download images to MCC once 
complete  

 
MAPPING 

•√No shadows on OMS pod 
tiles 

• Remove window shields 
• 50 percent overlap mapping 

of both OMS pods and 
vertical stabilizer 
w/emphasis on Black Tile 
areas 

• Repeat thru other window
 

 

 2. 
 

20A-6 

ISS Still Survey D2Xs
28-70mm@50mm 

(80-200mm@200mm) 
 

   
Map ISS surfaces w/30% overlap 

from all Flt Deck windows • Surfaces 
• Solar Panels 
• Handrails 
• MISSE 
• SVS Targets 
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P/TV08   EXTERNAL SURVEY (Continued) 

OPS (Continued) 

 



 FS 1-65 P/TV/130/FIN A 

P/TV08   EXTERNAL SURVEY (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
PWR – OFF 
Flash ON/OFF – ON 
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P/TV09   GLACIER 

H/W SUMMARY 

jsc48038_130_019r1.cvx

Audio Muting
Plug (optional)CC on Batt Pwr

Multiuse Arm
(optional)

G1

MD CC

 

P/TV09 
GLACIER         
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P/TV09   GLACIER (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining in-cabin video,still images of GLACIER payload 
 

SETUP 

 1. Perform Camcorder Setup for MD per H/W SUMMARY, FS 1-68, as reqd 
 

√Batt installed 
 

G1 Install Wide Conversion lens 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt (optional) 
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P/TV09   GLACIER (Continued) 

SETUP (Concluded) 

 2. Perform D2Xs PROGRAM w/FLASH 
 

Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                    
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

TTL BL
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P/TV09   GLACIER (Concluded) 

OPS 

√ Item # 
Track # Rqmts 

Still Imagery Video 
Notes 

DCS PLB CC Dnlk 
 1. 

 
 

GLACIER Installation and crew 
activity Video,Still Photography

D2Xs
12-24mm 

G1
LIVE 

(if avail) 

PLAYBACK 
desired 

 

There are two sample 
insertion/removal 
activities; both are to be 
videoed 

Playback required within 
12 hrs 

Take 6 images at a 
minimum 

–  2 @ wide angle 
–  2 @ medium angle 
–  2 @ closeup of front 

panel 

• Still images of GLACIER 
installed in Middeck 
(2 images taken of wide 
view, and close-up of 
hardware and front panel) 

• Video of crew performing an 
activity at the GLACIER in 
Middeck (hardware prep, 
sample insertion/removal)

• Video of GLACIER front 
panel configuration after 
transfer is complete 

• Video of crew interaction 
with GLACIER (hardware 
status check, sample 
insertion/removal) 
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        P/TV10 
SEITE,SIMPLEX 
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P/TV10   SEITE,SIMPLEX PAYLOADS 

SCENE SYNOPSIS 

Scene contains procedures for documenting the SEITE and SIMPLEX OMS burns 
 

SETUP 

 1. Remove window shields prior to setup 
 

 2. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 
 

 3. D2Xs Camr Config for SEITE,SIMPLEX (D2Xs Shutter Priority Mode) 
 

SB-800 Flash Settings 
ON/OFF pb – OFF 

 
Lens – 28mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (     ) – 0.0 
Exp Mode – S 

SS – 500 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 

        P/TV10 
SEITE,SIMPLEX 
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P/TV10   SEITE,SIMPLEX PAYLOADS (Continued) 

SETUP (Continued) 

 3. D2Xs Camr Config for SEITE,SIMPLEX (D2Xs Shutter Priority Mode) (Concluded) 
 

Menu Settings: 
MENU pb – press 
Navigate Pad sel – Shooting Menu ( ) Hi-speed Crop > On 
Navigate Pad sel – Custom Settings Menu > d Shooting/Display > d1 Shooting Speed > 4 fps 

 
Accessory Equipment 

Shutter Release Cable – install 
Multiuse Base – install in W9/10 
Multiuse Brkt – install on Base 

 
Technique 
Frame image per picture at right 
Focus on OMS pod 
Body Focus Mode – M 

 
 4. Perform Hardware Verification for DTV 

 
L10 (MUX) VTR/CC PWR – on (LED on) 

 
L10 (VIP) √ATU – REC 

√CCTV VIDEO IN – J3 
PWR – on (LED on, DATA FLOW flashes twice) 

 
L10 (VTR) √ON/STANDBY LED – green 

 
√Switches set to white dot (seven) 

 
√COUNTER SELECT – COUNTER (TC) 

 
√Tape installed (tape icon LED on) 
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P/TV10   SEITE,SIMPLEX PAYLOADS (Continued) 

SETUP (Concluded) 

 4. Perform Hardware Verification for DTV (Concluded) 
 

Set GMT: 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓ pb – CLOCK SET, EXEC pb – push 
Use ↓, ↑,EXEC to set Y,M,D,hr,min to GMT 
DISPLAY SELECT – DATA 

 
If Audio desired: 

L9  PS AUD PWR – AUD 
Desired Loops – RCV, Vol tw 5 
Other Loops – OFF 

 
A7 VID OUT DTV pb – push 

VID IN pb – A(D) 
 

L10 (VTR) REC pb – push, hold 
PLAY pb – push, simo (red dot displayed) 

 
OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video 
Notes 

PLB CC Dnlk 
 1. 

 
 

SEITE,SIMPLEX D2Xs
28mm 

A(D) LIVE
(if avail) 

√Focus set to OMS pod
 

 

• Initiate photo sequence 
1 sec prior to burn 

• Start recording on DSR-25 
5 min prior to burn 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 
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P/TV10   SEITE,SIMPLEX PAYLOADS (Concluded) 

DEACTIVATION 

 1. D2Xs 
Body Focus Mode – S 
Exp Mode – P 
Frame Rate – S 

 
Menu Settings 
MENU pb – press 
Navigate Pad sel – Shooting Menu ( ) Hi-speed Crop > OFF 
Navigate Pad sel – Custom Settings Menu > d Shooting/Display > d1 Shooting Speed > 3 fps 

 
 2. TV System 

Remove,mark tape for SEITE(SIMPLEX) 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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 FS 2-1 P/TV/130/FIN A 

REFERENCED PROCEDURES 

 PAGE 
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DTV 
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D2Xs 
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MINI-CAM 
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) 
LCS/IDC (HEATER ONLY MODE)/(OPERATIONAL PWR MODE) DATA AND PWR INTERFACES .......................................................  FS 2-18 
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CANON G1 
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HD G1 DNLK ..............................................................................................................................................................................................  FS 2-24 

FCS CHECKOUT CAMR SETUP 
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SETUP ........................................................................................................................................................................................................  FS 2-28 
DEACTIVATION .........................................................................................................................................................................................  FS 2-29 
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 FS 2-4 P/TV/130/FIN A 

CENTERLINE (C/L) CAMR 

C/L CAMR INSTALL 

 1. ODS C/L Camr Config 
L12 (SSP 2) √C/L CAM PWR – OFF 

 
R12 (VPU) √SEC C/L Cap installed 

√Green Jumper – SEC C/L 
√VPU PWR – ON (LED on) 

 
ML60B Unstow PRI C/L Camr, PRI C/L TV Camr Harness Assy 

 
NOTE 

When connecting ODS C/L TV 
Camr Harness Assy, √pins to 
socket connection 

 
ODS √ODS C/L Camr Brkt mounted securely 

Mount PRI C/L Camr to ODS C/L Camr Brkt 
√Flex Duct attached to Camr brkt 

Config cable per dwg at right 
 

C/L Camr √SSF/STS sw – STS 
 

L12 (SSP 1) √cb SW PWR 1 (CB2) – cl 
L12 (SSP 2) C/L CAM PWR – SEC ON 

 
A6L LT VEST PORT,STBD – ON as reqd 

 
Perform ACTIVATION (Cue Card, TV) as reqd 

 
A7 VID OUT MON 1(2) pb – push 

VID IN PL2(VPU) pb – push 
ALC pb – push 
AVG pb – push 

 

    C/L CAMR     

jsc48038_130_048r1.cvx

TV
(AW18H)

1 2

ODS
C/L

Camr

Ovhd Hatch

PRI C/L TV Camr Harness Assy
(V828–774057–004)

Pwr,SyncVideo

Wireless Video System
Interface Box

SEC C/L

VIDEO PROCESSING UNIT

SEC
C/L

(R12)

(ODS)
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CENTERLINE (C/L) CAMR (Continued) 

C/L CAMR INSTALL (Continued) 

 2. Camr Position Verification 
 

jsc48038_130_049r1.cvx

Existing
Shims for
Pitch/Yaw
Alignment

FWD

AFT

STBD
PORT

ÊÊÊ

NOTE
This view in ODS looking

up from Camr bottom

Cam r Housing
Bracket
Mounting
Subplate

Axial
Adjustment
Screw

Axial
Adjustment
Screw

TV

1 2

PRI C/L TV Camr Harness Assy (8.5 ft)
V828–774057–004

(ODS)
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CENTERLINE (C/L) CAMR (Concluded) 

C/L CAMR INSTALL (Concluded) 

 3. ODS C/L Camr Alignment Check 
MON 1(2) LDATA – ON 

CDATA – GRN 
XHAIR – GRN 

 
A7 Zoom to 10° ± 0.5° 

Focus to see Xhair target 
 

NOTE 
Green xhairs on monitor may move off center in 
calibration target when zooming in,out.  Xhair 
will be closest to center at full zoom in position 

 
MON 1(2) √Vertical xhairs coincide w/vertical alignment wire and are parallel.  If xhair marks overlay each other, no yaw(axial) alignment 

needed (see dwg above) 
 

√Intersection of monitor vertical,horizontal xhair falls within target circular opening from ~10-40° zoom range of Camr 
 

Report results of both alignment verifications (at 10° and 40°) to MCC 
 

 4. Deactivation 
A7 CAMR CMD IRIS – CL 
L12 (SSP 2) C/L CAM PWR – OFF 

Go to DEACTIVATION (Cue Card, TV) as reqd 
 

A6L LT VEST PORT,STBD – OFF as reqd 
 

jsc48038_130_050r1.cvx
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  DTV       
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DTV 

VTR CLOCK SET 

 1. Activate VTR 
 

R1 √PL AUX – ON 
 

L10 (MUX) VTR/CC PWR – on (LED on) 
L10 (VTR) √ON/STANDBY LED – green 

 
 2. Set VTR clock to GMT 

 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓ pb – CLOCK SET, EXEC pb – push 
Use ↑,↓,EXEC to set Y,M,D,hr,min to GMT 

 
DISPLAY SELECT – DATA 

 
 3. Deactivate VTR,VIP as reqd 

 
ON/STANDBY pb – push (red LED on) 

L10 (VIP) PWR – off (LED off) 
 

  DTV       
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D2Xs 

DATE/TIME SET 

 1. MENU pb – press 
 2. Navigate pad – sel Menu icon  setup menu 

Navigate pad – press (right) 
Navigate pad – sel WORLD TIME (up,down) 
Navigate pad – press (right) 
Navigate pad – sel DATE (up,down) 
Navigate pad – press (right) 

 3. Set TIME/DATE to GMT 
Navigate pad – sel desired field (left,right) 
Navigate pad – sel desired setting (up,down) 

 4. ENTER pb – press 
 5. MENU pb – press twice 

D2Xs         
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MINI-CAM 

ENTRY VIDEO SETUP 

jsc48038_130_008r8.cvx

FLT DECK (O19)

TV

ASC/ENT/FD TV Pwr Cable (10 ft)
(2293284–504/528–20650–1)

Pwr

PIGMY

AVIU

J2

J4

J6

J1

J5

J3
J7

Dnlk Y Cable
(SED39127625–301)

Bottom of
Locker Cable CDR/HUD

Mini-Cam
On-OrbitCable

(SED39127626–301)

AVIU Adapter
Cable (1 ft)

(528-21088-1)
S–Band FM

Signal
Processor

(PL Analog)
L10:A1 Locker

CDR/HUD
Mini–Cam

Extension Cable (13 ft)
(SED39127626–303)

VIDEO
HI

HI–Z

PS
CCU

UNBAL
J4

MUX

VTR

ATU

VTR/CC MUX/VTR/CC
ACT

MUX
BYPASS

IEEE 1394

VIP REC

CCTV
VIDEO IN

BAL
J3

J3

AUDIO IN/OUT

VTR
MONITOR

VIP OUT

VTR IN

VTR OUT

(Not Used)

DTV Audio Cable (25 ft)
(SED33104173–301)

Audio

Video

BNC
Straight
Adapter

RCA Phono Adapter
(SED39122368-001)

Batt

HUD
FD
V10

Pwr

Batt

MD
V10BNC

Straight
Adapter Entry MD V10 Cable

(SED39122269-301)
Video

Pwr

(Not
Used)

ASC/ENT FD
V10 Cable

(SED39122260-320)

CDR/HUD
Mini–Cam

Extension Cable (13 ft)
(SED39127626–303)

ASC/ENT FD
V10 Cable

(SED39105779–301)

DTV Bag Entry
Video Ziplock

Use Mini–Cam
body in Window 4

 

        MINI-CAM 
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MINI-CAM 

ENTRY VIDEO SETUP (Continued) 

MIDDECK M058F

TV

PIGMY

Pwr

SEAT 6 FDF BAG (Left)

AVIU Adapter Cable
(528-21088-1)

W4/MS
Mini-Cam

Extension Cable (13ft)
(SED39127626-303)

W4/MS
Mini-Cam

On-Orbit Cable (10ft)
(SED39127626-301)

AVIU

J2

J4

J6

J1

J5

J3
J7

VIDEO
HI

HI–Z

jsc48038_130_136r3.cvx

Entry Seat 6 - MS1
Video Cable

W4/MS
Mini-Cam

Extension Cable (13ft)
(SED39127626-303)

MIDDECK

FLIGHT DECK

Batt

HH
V10

MS1 FDF BAG

BNC-T

Entry Seat 6 - MS1
Video Cable

DTV Bag Entry
Video Ziplock
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MINI-CAM (Continued) 

ENTRY VIDEO SETUP (Continued) 

A17 1. Remove “Entry Video” Ziploc Bag from DTV Bag 
 

 2. Config Mini-Cams,V10,VTR for Audio,Video Recording 
Config H/W per dwg, FS 2-12 and FS 2-13 

 
 a. Config HUD Mini-Cam w/12mm Lens (use Mini-Cam body with 12mm lens in Window 4) 

HUD Brkt/Cam   Using two (2) captive screws, attach HUD Brkt to installation holes for protective cover w/HUD Brkt tab pointing up 
Attach Tie Wrap thru holes on captive screws to prevent screw from coming loose; cut off extra length on Tie Wrap 

 
Attach CDR/HUD Mini-Cam Extension Cable to HUD Mini-Cam 

 
12mm Lens   Focus – ∞ 

Aperture – f/5.6 
 

Velcro Mini-Cam w/12mm Lens to HUD Brkt.  (Top of black Velcro on front of Camr should be at top edge of HUD Brkt.  
Only yellow Velcro should be visible above HUD Brkt) 

 
 b. Config additional Mini-Cam H/W 
 

L10:A1   AVIU 
SYNC/VIDEO – VIDEO 
HI-Z/75 – HI-Z 
PWR SELECT – HI 

 
O19,MO58F     √TV PWR – ON 

 
PS ATU   Config audio as reqd for entry audio 

 
L10 (MUX)   VTR/CC PWR – on (LED on) 
L10 (VTR)     √ON/STANDBY LED – green 
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MINI-CAM (Continued) 

ENTRY VIDEO SETUP (Continued) 

 b. Config additional Mini-Cam H/W (Concluded) 
 

Acquire six (6) V10 Li-ION batts 
 

NOTE 
One Batt will be used on V10s for system c/o.  Second Batt 
is spare.  Batts will be removed after c/o and used for Entry 

 
NOTE 

TV,V10 pwr will be re-enabled per ENT AFT FLT DECK 
CONFIG 15 (DEORB, NOMINAL DEORBIT PREP); recording 
will be initiated via ENTRY C/L 

 
For HUD Mini-Cam: 

Focus – Adjust per MS1 V10 
Aperture – Adjust per MS1 V10 
If needed, turn down brightness on HUD display 
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MINI-CAM (Concluded) 

ENTRY VIDEO SETUP (Concluded) 

MS1 HH Attach W4/MS Mini-Cam Extension Cable to Handheld (HH) Mini-Cam 
 Mini-Cam 

 
 c. Config MS1 Handheld w/3.5mm lens 

3.5mm Lens  Aperture: 
If night landing:  f/1.8 
If daylight landing:  f/5.6 (dot between 8 and 4) 

 
SEAT 6 d. AVIU 
 FDF Bag  SYNC/VIDEO – VIDEO 

  HI-Z/75 – HI-Z 
  Pwr SELECT – HI 
 

V10s  Install fresh BATTs 
 (MS1 HH & HUD) √Handheld video displayed on V10 

√HUD video displayed on second V10 
PWR – off 
Remove, temp stow BATTs 

MO58F,O19 TV PWR – OFF (when L-1 comm checks complete) 
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) 

LCS/IDC (HEATER ONLY MODE)/(OPERATIONAL PWR MODE) DATA AND PWR INTERFACES 

CNTL
BUS
AB2

Conv

Output

28V

Converter 124V

MCC
LCS Ground
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) (Concluded) 

PTU 2/MAIN BUS B SYSTEM DETAILS 

MNB

ESS2CA

MNB
CONTR

O13

jsc48038_130_PTU2_134er1.cvx
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CANON G1 

ANALOG (DTV SD) G1 REC,DNLK 

Config H/W per dwg at right 
 

AVIU SYNC/VIDEO – VIDEO 
HI-Z/75 – 75 
PWR SELECT – LO 

 
O19(MO58F) √TV PWR – ON 

 
G1 √Wide Conversion lens installed 

√ND FILTER – OFF 
Install Audio Muting Plug (optional) 

√OUTPUT – CAM 
√A/V1/V2 – V2 
√  
√STANDBY/LOCK – STANDBY 

Install Audio Muting Plug (optional) 
PWR dial – “green”  grn 
If rec to tape: 

Tape – Install 
√Viewfinder (LCD) displays “green”  •|| 

Multiuse Brkt, Clamp as reqd 
 

CAUTION 
Due to temp constraints, worklights at full 
pwr for 60 min; 90% pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light(s) w/brkts (Velcro/tape) 
PWR – as reqd 

 
Cabin Lts Flt Deck – ON 

Lts in FOV – OFF as reqd 
Lt Shades – install as reqd 
Window Shades – install as reqd 

 
G1 √Scene composition 

 
Adjust Camr angle for best framing 

    CANON G1     

Handheld Mic

CCU

jsc48038_130_021r4.cvx
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CANON G1 (Continued) 

ANALOG (DTV SD) G1 REC,DNLK (Concluded) 

CCU CCU PWR – ON 
 

ATU PWR – AUD 
A/G 1(2) – T/R 
All Other Loops – OFF 
XMIT/ICOM MODE SEL – PTT/PTT 
MSTR SPKR VOL SEL – as reqd 

 
When ready for dnlk: 

A7  √TV DNLK – ENA 
TV PWR CNTL – PNL 
TV PWR CONTR UNIT – MNA(B) 
TV PWR CNTL – CMD (wait 10 sec for system initialization) 

 
If Analog, on MCC GO: 

VID OUT DNLK pb – push 
VID IN FLT DECK(MIDDECK) pb – push 

If DTV SD, on MCC GO: 
L10  √Cables connected 
 (MUX)  MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
 (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
 (VTR)  √ON/STANDBY LED – green 

√INPUT SELECT – VIDEO 
A7  VID OUT DTV pb – push 

VID IN FLT DECK(MIDDECK) pb – push 
L10 (MUX)  √CH 3 DATA LED – on 

 
When dnlk complete: 

G1  PWR dial – OFF 
Worklights  PWR – off 
L10 (MUX)  MUX/VTR/CC PWR – off (LED off) 

 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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CANON G1 (Continued) 

HD G1 DNLK 

Notify MCC, configuring for HD TV dnlk 
 

Config H/W per dwg at right 
 

G1 For cable strain relief attach MPC-to-G1 Cable 
Velcro strap to CC strap 

 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO  

O19 √TV PWR – ON  
G1 √Wide Conversion Lens installed 

Install LAV MIC 
√ND FILTER – OFF 
√OUTPUT – CAM 
√                    
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
If rec to tape: 

TAPE – INSTALL 
√Viewfinder (LED) displays green  •|| 

Mount Camcorder  
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 0,1 RATE SEL – 1 

  √2 RATE SEL – 8  
L10 (VTR) ON/STANDBY pb – push (LED red) 
L10 (VIP) PWR – OFF (PWR LED-off)  
O19 DC UTIL PWR MNA – ON 
MPC PWR DC PWR SPLY PWR SW1 – ON 
 SPLY 
MPC PWR – ON (HDV, TAXI, 5V, 3V green LEDs on)  
L10 (MUX) √CH 2 F/O OK,DATA LEDs on 

 

jsc48038_130_020r3.cvx
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CANON G1 (Continued) 

HD G1 DNLK (Continued) 

CAUTION 
Due to temp constraints, worklights at full 
pwr for 60 min; 90% pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light(s) w/brkts (Velcro/tape) 
PWR – as reqd 

 
Cabin Lts Flt Deck – ON 

Lts in FOV – OFF as reqd 
Lt Shades – install as reqd 
Window Shades – install as reqd 

 
G1 √Scene composition 

 
Adjust Camr angle for best framing 

 
LAV MIC PWR – ON (talk),OFF (listen) 

 
√MCC if Black video and color bars reqd 

If reqd: 
PWR dial – Av 
Aperture – close 

√Av CLOSE displayed on top left of LCD 
AGC – OFF 

√GAIN sw – L 
√±0dB displayed on LCD 

OUTPUT – BARS 
 

When MCC says done w/bars: 
OUTPUT – CAM 

 
When MCC says done w/black screen test: 

PWR dial – “green”  
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CANON G1 (Concluded) 

HD G1 DNLK (Concluded) 

When dnlk complete: 
G1 PWR dial – OFF 

 
Worklights PWR – off 

 
O19 TV PWR – OFF as reqd 

 
MPC PWR – OFF 
MPC PWR DC PWR SPLY PWR SW1 – OFF 
 SPLY 
O19 DC UTIL PWR MNA – OFF 
L10 (MUX) MUX/VTR/CC PWR – off (LED off) 
L10 (VIP) PWR – ON (LED on, DATA FLOW LED flashes twice) 
L10 (VTR) ON/STANDBY pb – push (LED green) 

 
Notify MCC, returned to SD TV dnlk 

 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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FCS CHECKOUT CAMR SETUP 

SCENE SYNOPSIS 

The following camera and camcorder settings will be used to photodocument items or debris that may become liberated from 
the Orbiter during FCS C/O.  Images and video should be downlinked if time and/or assets are available  

SETUP 

 1. D2Xs  
Lens – 400mm  

NOTE 
If auto focus unachieveable: 

Lens Focus Mode – M  
Aperture – Min, locked 
Lens Focus Limit – ∞-6m 
Lens Focus Mode – A 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp – 0.0 
Exp Mode – M 

SS – 500 
f/stop – f/8 

Meter – Matrix 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [ ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  

SB-800 Flash Settings 
ON/OFF pb – OFF 

  FCS       
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FCS CHECKOUT CAMR SETUP (Concluded) 

SETUP (Concluded) 

 2. G1  
Remove Wide Conversion Lens 
Install Batt 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M 
√Tape installed 

Open LCD 
√‘green’  •|| displayed 

SS – 1/500 
√GAIN – 0dB 

f/stop – F8.0 
√FOCUS – M ∞- 

 
DEACTIVATION 

 1. D2Xs 
Lens focus mode – A 
EXP Mode – P 
Pwr – OFF 

 
 2. G1 

Install Wide Conversion Lens 
AF/M – AF 
AGC – ON 
Pwr dial – OFF 
Remove Batt 
Connect Dig/CC Vid Pwr Cable 
PWR dial – ‘green’    
Place G1 on brkt 
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CUE CARD CONFIGURATION 

 PAGE 

TV ............................................................................................................................................................................................................  FS CC 3-3 
ANALOG PLAYBACK ..............................................................................................................................................................................  FS CC 3-5 
ET PHOTO ..............................................................................................................................................................................................  FS CC 3-7 
MEDIA ALLOCATIONS ...........................................................................................................................................................................  FS CC 3-8 
WVS .........................................................................................................................................................................................................  FS CC 3-10 
PLBD VTR RECORDING ........................................................................................................................................................................  FS CC 3-12 
LDRI/ITVC ...............................................................................................................................................................................................  FS CC 3-14 
LCS ..........................................................................................................................................................................................................  FS CC 3-16 
IDC ...........................................................................................................................................................................................................  FS CC 3-18 
VIDEO SETUP .........................................................................................................................................................................................  FS CC 3-20 
D2Xs SETUP ...........................................................................................................................................................................................  FS CC 3-22 
LDRI/ITVC A7 PLACARD ........................................................................................................................................................................  FS CC 3-24 
DIGITAL PLAYBACK ...............................................................................................................................................................................  FS CC 3-25 
G1 SETUP CUE CARD ...........................................................................................................................................................................  FS CC 3-27 
 

    CUE CARDS     
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HOOK 
VELCRO 

 
TV

ACTIVATION  
A3 MON 1(2) PWR – ON (LED ON) 
A7 √TV DNLK – ENA 

TV PWR CONTR UNIT – MNA(B) 
TV PWR CNTL – PNL, wait 10 sec for system initialization, CMD

 

OPERATION 
 

Auto Ops (Auto Exposure) 
 √MCC has commanded sync config 
A7 TV CAMR PWR A(B,C,D,RMS) – ON (tb-ON) 

VID OUT MON 1(2) pb – push 
VID IN pb – as reqd 
If CTVC: 

ALC pb – push 
AVG pb – push 

If ITVC: 
If MAN GAIN pb not illuminated: 

TV CAMR PWR A(B,C,D,RMS) – OFF, wait 10 sec, ON 
Repeat until MAN GAIN pb il luminated 

LT LEVEL pb – push 
DAY(NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

 
Dnlk Ops 

Coordinate dnlk and sync config w/MCC 
Config audio as reqd 

 
If analog, on MCC GO: 

A7  VID OUT DNLK pb – push 
VID IN pb – as reqd 

If DTV, on MCC GO: 
L10  √Cables connected 
  (MUX)  MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
  (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
  (VTR)  √ON/STANDBY LED – green 

√INPUT SELECT – VIDEO 
A7  VID OUT DTV pb – push 

VID IN pb – as reqd 
L10 
  (VIP)  √DATA FLOW LED – on 
  (MUX) √CHANNEL 3 DATA LED – on

Manual Ops – CTVC/ITVC (Manual Exposure) 
CAUTION 

DO NOT LEAVE CAMRS UNATTENDED IN MANUAL 
MODE.  DIRECT SUNLIGHT WILL DAMAGE CAMRS

 
Manual Exposure ON 
A7 MAN GAIN pb – push 

0(+12,+24) dB pb – push 
CAMR CMD IRIS – OP,CL  

Return to Auto Exposure 
ALC pb – push 
AVG pb – push 

 
MUX Ops 

NOTE 
Although dnlk/rcd is in color, MON 
will display MUX in B&W  

A7 VID OUT MON pb – as reqd 
VID IN MUX 1(2) pb – push 
VID OUT MUX 1(2) L pb – push 
VID IN pb – As reqd 
VID OUT MUX 1(2) R pb – push 
VID IN pb – as reqd 

 
For RSC ops: 

Go to LDRI/ITVC Cue Card 
 
 

DEACTIVATION 
If Illuminator ON:

Refer to Illuminator Ops and perform Illuminator OFF 

 
A7 PORT RMS CAMR – WRIST 

TV CAMR PWR A(B,C,D,RMS) – OFF (tb-OFF), wait 10 sec 
PORT RMS CAMR – ELBOW 
TV CAMR PWR RMS – ON (tb-on), wait 10 sec, OFF (tb-OFF) 
TV PWR CNTL – PNL 
TV PWR CONTR UNIT – OFF 
TV PWR CNTL – CMD 

A3 MON 1,2 PWR – OFF 

 
If DTV: 

L10 
  (VTR)  ON/STANDBY pb – push (red LED on) 
  (VIP)  PWR – off (LED off) 
  (MUX)  MUX/VTR/CC PWR – off (LED off) 

VTR/CC PWR – off (LED off)

 

 

P/TV-1a/130/O/A

 (reduced copy) 
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HOOK 
VELCRO 

 

Illuminator Ops 

Illuminator ON 
If Wrist Illuminator: 

R14:D(E)  √cb TV RMS CAMR/PTU – cl 
cb TV RMS √WRIST ILLUM/CAMR HTR – cl 
√cb TV RMS WRIST ILLUM/CAMR HTR – op,cl 

If Elbow Illuminator 
√cb TV RMS CAMR/PTU – cl 
cb TV RMS √ELB ILLUM/PTU HTR – cl 
√cb TV RMS ELB ILLUM/PTU HTR – op,cl 

If A(B,C,D,ELB) Illuminator: 
√cb TV A(B,C,D,RMS,ELB) CAMR/PTU – cl 
cb TV A(B,C,D,RMS,ELB) √ILLUM/PTU HTR – cl 
√cb TV A(B,C,D,RMS,ELB) ILLUM/PTU HTR – op,cl 

 
Illuminator OFF 

If Wrist Illuminator: 
R14:D(E)  cb TV RMS WRIST ILLUM/CAMR HTR – op,cl 

If Elbow Illuminator: 
cb TV RMS ELB ILLUM/PTU HTR – op,cl 

If A(B,C,D,ELB) Illuminator: 
cb TV A(B,C,D,RMS,ELB) ILLUM/PTU HTR – op,cl 

If RSC Illuminator: 
Go to LDRI/ITVC (Cue Card) 

 
 

jsc48038_130_011r1.cvx
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ANALOG PLAYBACK 
ANALOG VIA G1 ANALOG VIA VTR 

NOTE
Analog Playback from G1 only possible for G1 Video recordings  
ACTIVATION ACTIVATION 
G1 Setup per diagram (back of cue card)
A7 Perform ACTIVATION (Cue Card, TV), as reqd 
O19 √TV PWR – ON 
 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
G1 PWR – VTR/PLAY 

√A/V1/V2 – V2 
 

Setup per diagram (back of cue card)
Disconnect CC Video input from AVIU J3 
Perform ACTIVATION (Cue Card, TV) as reqd 

O19 √TV PWR – ON 
 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

L10 
 (MUX) √VTR/CC PWR – on (LED on) 
 (VTR) √ON/STANDBY LED – green 

OPERATIONS OPERATIONS 
PLBK or DNLK VIDEO PLBK or DNLK VIDEO 

G1 Install tape, if reqd
 

If audio reqd: 
CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – RCV(OFF) 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX 

 
G1  Speaker Vol Max 
 
A7 VID OUT MON pb – as reqd 

VID IN FLT DECK(MIDDECK) pb – push 
G1 VTR pb – REW(FF) to cue tape 
 
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
VID IN FLT DECK(MIDDECK) pb – push 

 
G1 PLAY pb – push (green  displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If G1 ops complete, go to DEACTIVATION 
 

L10 (VTR) Install tape if reqd 
 √DISPLAY SELECT – DATA 
 

If audio reqd: 
L10 (VIP)  PWR – on (LED on, DATA FLOW LED 

flashes twice) 
ATU – PBK/KEY MIC (Amber LED on) 

CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – OFF 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX 

 
A7 VID OUT Desired MON pb – push 

VID IN FLT DECK pb – push 
L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to 

cue tape 
 
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
VID IN FLT DECK pb – push 

 
L10 (VTR) PLAY pb – push (green • displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If VTR ops complete, go to DEACTIVATION 
 

DEACTIVATION DEACTIVATION 
G1 Remove, write protect, mark, stow tape as reqd

PWR – OFF 
ATU Reconfig as desired 
O19 TV PWR – OFF, as reqd 

Go to DEACTIVATION (Cue Card, TV), as reqd 
 

Connect CC video input to AVIU J3
L10 (VTR) Remove, mark, stow tape as reqd 
ATU Reconfig as desired 
O19 TV PWR – OFF as reqd 

Go to DEACTIVATION (Cue Card, TV) as reqd 
 

 P/TV-2a/130/O/B
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ANALOG VIA G1 PLAYBACK 

 

ANALOG VIA VTR PLAYBACK 
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P/TV-3b/130/O/B

ET PHOTO 
G1 CC  G1 CC 

 
LENS CAP – REMOVE 
INSTALL MUTING PLUG 

 
√ND FILTER – OFF 
√AF/M – M 
√AGC – OFF 
√GAIN – L 
√OUTPUT – CAM 
√AWB – ON 
√POWER dial – M 
√LOCK (handle) – off (aft) 
STANDBY/LOCK – STANDBY 

 
OPEN LCD 
√BATT SUFFICIENT 
√EXP MODE – M 
√SS – 1/1000 
√GAIN – ±0dB 
√F/STOP – F8.0 
√FOCUS MODE – MF ∞ 

 
ZOOM – WIDE TO FIND TANK, THEN TIGHT 

 
START RECORDING 

 
√LCD DISPLAYS REC 

 

P/TV-3a/130/O/B

TOP 
 

HOOK 
VELCRO 

ET PHOTO 
D2Xs  D2Xs 

 
LENS SETTINGS 

 
√APERTURE – MIN, LOCKED 
√LENS FOCUS MODE – A 

 
CAMR SETTINGS 

 
PWR – ON 
TOP LCD 
√BATT 
√EXP MODE – M 
√SS – 1000 
√F/STOP – 8 

 
DIOPTER – ADJUST 
√FRAME RATE – S 
√BODY FOCUS MODE – S 

 
REAR LCD 
√ISO – 100 
√QUAL – RAW 

 
CRITICAL FOCUS REQD EACH FRAME 
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TOP 
 

 

MEDIA ALLOCATIONS
DVCAM 3 hr/tape 
 

     15 14 13 12 11
10 9 8 7 6 5 4 3 2 1 

 

 

MINI DVCAM 40 min/tape 
 

     225 224 223 222 221 
220 219 218 217 216 215 214 213 212 211 
210 209 208 207 206 205 204 203 202 201 
200 199 198 197 196 195 194 193 192 191 
190 189 188 187 186 185 184 183 182 181 
180 179 178 177 176 175 174 173 172 171 
170 169 168 167 166 165 164 163 162 161 
160 159 158 157 156 155 154 153 152 151 
150 149 148 147 146 145 144 143 142 141 
140 139 138 137 136 135 134 133 132 131 
130 129 128 127 126 125 124 123 122 121 
120 119 118 117 116 115 114 113 112 111 
110 109 108 107 106 105 104 103 102 101 
100 99 98 97 96 95 94 93 92 91
90 89 88 87 86 85 84 83 82 81
80 79 78 77 76 75 74 73 72 71
70 69 68 67 66 65 64 63 62 61
60 59 58 57 56 55 54 53 52 51
50 49 48 47 46 45 44 43 42 41
40 39 38 37 36 35 34 33 32 31
30 29 28 27 26 25 24 23 22 21
20 19 18 17 16 15 14 13 12 11
10 9 8 7 6 5 4 3 2 1 
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CAMR ADJUSTMENTS ANTENNA LOCATIONS 
ADJUST BRIGHTNESS 

Course Adjustment 
PGSC Select Page – RF Camera 

Lens Iris Control – cl(op) 
 

Fine Adjustment 
PGSC Select Page – RF Camera 

Electronic Shutter – Manual 
Brightness – Dec(Inc) 

(# to right:  100 = brightest; 0 = darkest) 
 
DARK SUBJECT 

PGSC Select Page – RF Camera 
√Advanced Controls displayed 

Automatic Gain Control – Enabled 
(Disabled preferred) 

 
PWRDN 

For all lens (three) on each RF Camera Assy: 
PGSC Lens Iris Control – Close until view black 
 

Sel RF Camr 1,2 – None (black “OFF”) 
V10 √Test Pattern displayed (color bars w/“No WVS 

Video”) 
PGSC Select Page – XCVR 

Transceiver 1(2) CMD Pwr – Off 
(black CMD PWR:LVL–“OFF:Min”) 

Sel File → Exit 
 
V10 STOP pb – push 

Mark,stow tapes 
PWR – OFF 

 
A7 WIRELESS VID PWR – OFF 
  WIRELESS VID HTR – OFF 
 

VIDEO SIGNAL PROBLEMS 

For problem EMU TV: 
EMU EMU TV Pwr pb – push (no LED), wait 10 sec, push 

               (green LED) 
 
 If no joy: 
PGSC √Select Page – XCVR 

√SAdvanced Controls displayed 
For XCVR w/Video problem:  IF – Narrow 

 
 If still no joy: 
A7 WIRELESS VID PWR – OFF, wait 10 sec, ON 
 
 If still no joy: 
PGSC For XCVR w/video problem:  IF – Wide 

For XCVR w/good video:  Sel RF Camr – None (black ‘OFF’) 
If video acceptable, other EMU TV interfering w/signal 
Alternately sel EMU TVs to acquire video 

 
 If still no joy: 

For XCVR with good video: 
Sel RF Camr – reselect original EVA crewmember 

For XCVR w/video problem:  Antenna – Manual 
Sel desired antenna 

 
 If still no joy: 

For XCVR w/video problem:  Antenna – Auto 
√MCC 

 
COMMANDING PROBLEM (UHF) 

 If commanding of WVS not visually seen: 
PGSC Select Page – XCVR 

Sel Transceiver 2(1) CMD Pwr – On 
(green CMD PWR:LVL–“ON:Min”) 

jsc48038_130_108r1.cvx
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STATIC XCVR 
Condition: No comm between PGSC & PLB XCVR  
PGSC 1. √Cable connections between WIB and PGSC  
A7 2. WIRELESS VID PWR – OFF, wait 10 sec, ON  

If no joy: 
PGSC 3. Sel ‘Start’ > ‘Shut Down’ > ‘Restart’ > ‘OK’ 

When reboot complete: 
Sel Shuttle Apps icon > WVS icon 
Sel ‘Yes’ at ‘Restore To Previous Settings’ window 
RF Camera page will appear  

If still no joy: 
 4. √MCC  
STATIC RF CAMERA 
Condition: No telemetry and video received by PLB XCVR from EMU TV  
EMU 1. √EMU TV Pwr pb pushed (green LED)  

If no joy: 
PGSC 2. √Correct RF Camera selected via pulldown menu 

√RF Camera (two) – ON (green “ON”) 
If not ON: 

RF Camera (of static EMU TV) – sel “None” via 
pulldown menu, then sel original EMU TV  

If still no joy: 
 3. RF Camera 1(2) – sel “None” 

Perform CAMR ID ASSIGNMENT 
Reattempt RF Camr selections  

If still no joy: 
 4. √CMD PWR:LVL – green “ON:Min” for XCVR 1(2) 

If not ON, 
Select Page – XCVR 
Transceiver 1(2) CMD Power – On  

(green CMD PWR:LVL –“ON:Min”)  
If still no joy: 

EMU 5. EMU TV Pwr pb (of static EMU TV) – push (no LED),  
    wait 10 sec, push (green LED)  

If still no joy: 
6. √MCC 

BAD CAMERA ID 
Condition: Mismatch between EMU TV Camera ID and software camera ID  
PGSC 1. Select Page – XCVR 

Transceiver 1(2) CMD Power – On (green CMD PWR:LVL –“ON:Min”) 
Sel RF Camera 1,2 – None 
Sel File > Assign Camera ID 

√Camera IDs match data under CAMR ID ASSIGNMENT 
If not a match, 

Highlight entry, then sel ‘Delete Entry’ option 
Perform CAMR ID ASSIGNMENT 
Sel RF Camera 1,2 – EVA crewmembers  

If still no joy: 
 2. √MCC  
TEMP ALERT (blue text) 
Condition: EMU TV -35 °C to -30 °C  OR  80 °C to 85 °C range 
 PLB XCVR -40 °C to -35 °C  OR  80 °C to 85 °C range  

Select Page – Telemetry 
Identify component w/temperature alert (blue text) 

√MCC  
TEMP CAUTION (yellow text) 
Condition: EMU TV < -35 °C  OR  > 85 °C 
 PLB XCVR < -40 °C  OR  > 85 °C  

Select Page – Telemetry 
Identify component w/temperature alert (yellow text) 

√MCC 

 

CAMR ID ASSIGNMENT 
Sel File → Assign Camr ID 

√All EV crewmembers listed as options on pulldown ‘Label’ menu under CAMERA ID SETUP  
If label entry reqd: 

Type label into space next to “Add Label” icon 
Sel “Add Label” icon to add to listing  

Under CAMERA ID SETUP: 
Camera Address – As reqd via left/right arrows 
Serial Number – As reqd via left/right arrows 
Label – As reqd via pulldown menu 
“In Use” Box – Check via single click 
Sel “Save Entry” icon to right of Camr ID table (top) 
√Data entry visible in Camr ID table  

Sel OK P/TV-5b/130/O/A

Camr ID Data
Camr Address 16 18
Serial Number 1010 1007
Label EV1 EV2
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PLBD VTR RECORDING 
 
L10 √VIP,VTR covers removed 
 
R1 √PL AUX – ON 
 
MA73C:E cb AC2 PL3Φ – cl 
 

√Cables config’d per dwg (back of cue card) 
L10 
 (MUX) VTR/CC PWR – on (LED on) 
 
 (VIP) √ATU – REC 

√CCTV VIDEO IN – J3 
PWR – on (LED on, DATA FLOW flashes twice) 

 
 (VTR) √ON/STANDBY LED – green 
 

√Switches set to white dot (seven) 
 

√COUNTER SELECT – COUNTER (TC) 
 

√Tape installed (tape icon LED on) 
 

Set GMT: 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓pb – CLOCK SET, EXEC pb – push 
Use ↓, ↑,EXEC to set Y,M,D,hr,min to GMT 
DISPLAY SELECT – DATA 

 
If Audio desired: 

L9  PS AUD PWR – AUD 
Desired Loops – RCV, Vol tw 5 
Other Loops – OFF 

 
A7 VID OUT DTV pb – push 

VID IN pb – as reqd 
 
L10 
 (VTR) REC pb – push, hold 

PLAY pb – push, simo (red dot displayed) 
 

TOP 
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ACTIVATION 

1. Config CCTV Sys 
A7 √ACTIVATION (Cue Card, TV) performed 
L10 (VTR) √DTV VTR Clock is set 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√Cabling from VTR MON port to MON 2 
C-IN 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – LDRI/ITVC 
√RSC Vid Cable connected to WIB CCTV 

PL/3 
MON 1,2 L-DATA – ON 
 C-DATA – GRN 
 X-HAIR – GRN 

 
MON 2 SOURCE – C 

 
2. Apply SPEE Pwr 

R12 (OPP) √cb OBSS SW PWR – cl 
√OBSS SW PWR – ON 

R12 (OBSS) SPEE PWR – ON 
A6U EVENT TIMER CNTL – STOP 
 EVENT TIMER – RESET 
 EVENT TIMER CNTL – START  

(15 min LDRI calibration warmup) 
 
3. Config RSC Illum to HI 

A7 VID OUT MON 1 pb – push 
VID IN C pb – push 

 PAN/TILT – Adjust to see RSC Camr 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, ON 
MON 1 √RSC illum on HI (three rings) 

 
4. Enable ITVC 

√MCC has commanded sync config 
R12 (OBSS) ITVC ENA – ON 
A7 VID OUT DTV pb – push 

VID IN PL 2(VPU) pb – push 
If MAN GAIN pb not illuminated: 

R12 (OBSS) ITVC ENA – OFF, wait 10 sec, ON 
Repeat until MAN GAIN pb 

illuminated 
A7 LT LEVEL pb – push 

DAY (NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

MON 2 √ITVC video displayed 
 
5. Turn LDRI Laser On 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 
LDRI MODE 2 pb – push 

 VID OUT DTV pb – push, to return to 
ITVC control 

GENERAL LDRI CONTROL 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 

 
Mode 1 (default at pwrup) 
A7 LDRI MODE 1 pb – push 
MON 2 √ITVC video displayed 
 
Mode 2 
A7 LDRI MODE 2 pb – push 
MON 2 √ITVC video w/illum displayed 
 
Modes 3 (4,5,6) 
A7 LDRI MODE 3(4,5,6) pb – push 
MON 2 √LDRI w/rounded corners displayed 

To adjust brightness: 
A7  CAMR CMD IRIS – OP,CL, as reqd 
 
PAN/TILT OPS WITH LDRI ACTIVE 

NOTE 
When adjusting pan/tilt in Modes 
3(4,5,6), ITVC FOCUS (ZOOM, 
IRIS) cntls  functional 

 
A7 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 

CAMR CMD PAN,TILT – as reqd 
VID OUT MUX 1 L pb – push, to return to LDRI cntl 
 

DEACTIVATION 

A7 VID OUT MUX 1 L pb – push 
VD√IN MIDDECK pb – lt on 
LDRI MODE 1 pb – push 

 
R12 (OBSS) ITVC ENA – OFF, pause 10 sec 

SPEE PWR – OFF 
A6U EVENT TIMER MODE – UP 
 EVENT TIMER CNTL – START 
 
 
 

LDRI MODE SUMMARY

Mode 1 – Standby 
• ITVC video 
• LDRI in standby 
 
Mode 2 – Illuminator 
• ITVC video w/illum 
• LDRI laser active, LDRI camera  

inactive 
 
Mode 3 – 2D 
• LDRI 2D video 
• Similar to ITVC video 
 
Mode 4 – 2D Gamma 
• LDRI 2D video w/Gamma Black 

Stretch 
• Similar to ITVC video 
 
Mode 5 – 3D 
• LDRI 3D video 
• Flicker on MON 
 
Mode 6 – 3D Gamma 
• LDRI 3D video w/Gamma Black 

Stretch 
• Flicker on MON 
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RSC CAMR OPS 

NOTE 
Camr nominally pwrd in  3  of POST 
INSERT 

 
R12 (OPP) cb OBSS SW PWR CB1 – cl 

OBSS SW PWR – ON 
R12 (OBSS) RSC PWR – ON 
 
RSC ILLUMINATOR OPS 

NOTE 
RSC illuminator OFF when SPEE PWR 
sw initially taken to ON.  A cycle of the 
SPEE PWR sw takes RSC illuminator to 
HIGH.  Subsequent pwr cycles take 
illuminator to MED,LOW,OFF and then 
back to HIGH.  Config may req alt Camr 
view of RSC 

 
R12 (OBSS) √SPEE PWR – ON 

√RSC PWR – ON 
ITVC ENA – OFF 

A7 VID OUT MON 1 pb – push 
VID IN A(B,C,D) pb – push 
PAN,TILT – Adjust to see RSC Camr 

 
NOTE 

SPEE pwr cycle will reset LDRI/ITVC to 
Mode 1 and reset the PTU angles 

 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, ON 
MON 1 √RSC illum on 
 

To cycle thru illuminator modes: 
R12 (OBSS)  SPEE PWR – OFF, wait 10 sec, ON 
 

Perform LDRI/ITVC ACTIVATION, step 4 
 

Return to original LDRI/ITVC Mode, continue 
OPS 

 

CONTINGENCY LDRI CLEARANCE VIEW 

NOTE 
Do not apply RMS brakes

 
A8U AUTO SEQ – STOP (READY lt on) 
 
L10(VTR) STOP pb – push (no red •) 
 
A7 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 3(4) pb – push (steady LDRI video) 
 
 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 
 
 Record PTU Pan _________ and Tilt _________ 
 
 CAMR CMD PAN/TILT – HI RATE  
 CAMR CMD PAN:  0 (left, to hard stop) 
 CAMR CMD TILT:  0 (up, to hard stop) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Note clearance thru LDRI FOV 
 
 Return PTU to Pan and Tilt values recorded above 
 
 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 6 pb – push (flickering LDRI video) 
 
 VID OUT MON 1 pb – push 
 VID IN pb – as desired (not PL2) 
 
L10(VTR) REC pb – push,hold 
 PLAY pb – push, simo (red dot) 
 
A8U AUTO SEQ – PROCEED (IN PROG lt on) 
 

LDRI PAN/TILT RESET 

Reset PTU 
A7 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 
 
 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 
SPEE PWR DEACT CLEANUP ACTIONS 

Config RSC Illum to HI 
R12 (OBSS) √SPEE PWR – OFF 
 ITVC ENA – OFF 
 RSC PWR – OFF, wait 10 sec, ON 
 SPEE PWR – ON,OFF, wait 10 sec, ON 
 
Config ITVC 
 ITVC ENA – ON 
A7  VID OUT DTV pb – push 
 VID IN PL2(VPU) pb – push 
 If MAN GAIN pb not illuminated: 
R12 (OBSS)    ITVC ENA – OFF, wait 10 sec, ON 
    Repeat until MAN GAIN pb illuminated 
A7 LT LEVEL pb – push 
 DAY(NIGHT) pb – push 
 ALC pb – push 
 AVG pb – push 
 
Reset PTU 
A7 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 PAN and TILT ITVC to values needed for 

survey 
 
Return LDRI to Mode 6 
A7  VID OUT MUX 1 L pb – push 
 VID IN MIDDECK pb – push 
 LDRI MODE 6 pb – push 
 VID OUT DTV pb – push, to return to ITVC 

control 
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LCH ACTIVATION 
 Activate SSPTS APCU 2 
A15 √PTU 2 tb – ON 
 If NODE 3 not in PLB: 
  APCU 2 OUTPUT – ON 
 APCU 2 CONV – ON 
 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  123V to 126V 
 PTU 2 APCU √OUTPUT – ON 
 
LCC ACTIVATION 
1. LCC Setup 

 √Hardware and cables configured per diagram below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. LCC Startup 

A31p PGSC Pwr – ON 
 √Yellow ‘RJ-45 Port Configured for LCS Ops’ displayed on desktop crew 

patch 
 If yellow text not displayed, perform TROUBLESHOOTING, Yellow ‘RJ-

45 Port Configured for LCS Ops’ Not Displayed on Desktop Crew 
Patch 

 
 Sel ‘Shuttle Apps’ > ‘LCC’ (wait 2-3 min from APCU CONV–ON for 

GUI Status) 
 √Laser off – blue 
 √Comm – green 
 If Laser off and Comm status not correct:  √MCC 

 
3. Verify LCC Desktop Video 

MO58F √TV PWR – ON 
AVIU √HI-Z/75 – 75 
 PWR SELECT – LO 
MD G1 PWR – OFF 

3. Verify LCC Desktop Video (Concluded)
A31P Minimize all programs 
 Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘ENABLE DESKTOP DOWNLINK’, ‘ATI Property Page’ displayed 
 Sel ‘Yes’ 
 Maximize program windows as desired 

 
A7 VID OUT MON1(2) pb – push 
 VID IN MIDDECK pb – push 
A3 √LCC desktop displayed on MON1(2) 

 
* 
* 

If LCC Desktop not displayed
√MCC  

*
*

 
4. Verify GMT 

A31p √GMT on GUI lower right-hand side within 3 sec of SM-GPC GMT  
* 
* 
* 

If GMT not within 3 sec of SM GPC:
Sel ‘Tools’ > ‘Set GMT’  
Adjust GMT as reqd 
Sel ‘Apply’ > ‘OK’ 

*
*
*
 

OPERATION 
NOTE 

PDRS OPS will call for appropriate scan steps on LCC.  
MCC may have limited insight if desktop dnlk avail

 
1. Load Database (if reqd) 

 √MCC for desired LCS database 
 √‘DB Name’:  Field on upper left-hand side of LCS GUI  

* 
* 
* 

If ‘DB Name’ incorrect:
Sel ‘Load Database…’ from File menu 
Sel MCC desired database file 
Sel ‘OK’

*
*
*

 
2. LCS System Status 
 

LCS SYSTEM STATUS 
Laser On/Off Comm LCS State 

Laser ? (gray) No Comm
(yellow) 

Unknown or Keep Alive Heater Only Mode
(No LCC to LCH Network Connection) 

Laser Off (blue) Comm (green) Configuration
(Waiting for user command) 

Laser On (green) Comm (green) Operational
(Scan in progress) 

 
 While Scan in progress (‘Scan Status’ counter incrementing): 
 √Laser On – green 
 √Comm – green 
 √Scan Display – updating 
 √Temp – green 
 √Elec – green 
 Scan complete when ‘Scan Status:  Complete’ displayed  
 If LCS system status out of config, perform appropriate 

TROUBLESHOOTING section of this cue card 

 
P/TV-8a/130/O/B
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LCC DEACTIVATION 

NOTE 
Shutting down LCC software also puts LCH in 
keep-alive heater mode.  No LCH scans/insight or 
IDC ops available.  APCU Converter pwr cycle 
reqd to reinitialize LCH for scanning and IDC ops 

 
1. LCC Software Shutdown 

A31p Sel ‘File’ > ‘Exit’ 
 When ‘Shutdown’ dialog box opens: 
 √‘Shutdown LCH and Exit LCC Software’ selected 
 Sel ‘OK’ 
 When ‘Shutdown?’ dialog box opens: 
 Sel ‘OK’ 

 
2. A31p Screen Resolution Reset 

 
A31p Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK, ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

LCH DEACTIVATION 

CAUTION 
Deactivating SSPTS APCU 2 will remove 
critical keep-alive pwr to LCH and IDC.  
Pwr must be reapplied within 105 min 

 
1. Deactivate SSPTS APCU 2/LCH 
 

A15 APCU 2 CONV – OFF 
 

 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  <10V 

 
 If NODE 3 not in PLB: 
 APCU 2 OUTPUT – OFF 

TROUBLESHOOTING 

Temp or Elec Status Yellow  
A31p Sel ‘System’ page 
 Report ‘Elec’ or ‘Temp’ values backlit in yellow to MCC  
 
Comm Status Yellow and LAN2 Network cable unplugged (red X on A31p system tray) 
 

NOTE 
LCC GUI Comm status will be yellow and A31p Local Area Network 
status (w/red X on A31p system tray) cable unplugged tool tip will 
appear if LCH is in keep-alive heater mode 

 
A31p If unexpected red X w/Local Area Network Connection tool t ip shown on 

A31p system tray: 
 
 
 
 
 
 
R12 √OPP to LCC Cable connected to LCS CMD/TLM(J107) port 
A31p √OPP to LCC Cable connected to LCC RJ45 port 
 Exit LCC software and shut down Windows 
 
A15 APCU 2 CONV – OFF 
 APCU 2 OUTPUT – OFF, wait 10 sec, ON 
 APCU 2 CONV – ON 
 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS: 123V to 126V 
 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 
 Perform LCC ACTIVATION, step 2 
 
 √Local Area Network Connection status icon (with red X) in Windows system 

tray not displayed 
 √MCC if LCC GUI Comm status still yellow 
 
Message Area Entry 
 Report LCC GUI message area log entry(ies) to MCC 
 
Yellow ‘RJ-45 Port Configured for LCS Ops’ Not Displayed on Desktop Crew Patch 
A31p Sel ‘Shutt le Apps’ > ‘Network Configuration’ > ‘LCS RJ-45 Network Setup’ 
 Enter ‘1’ in network window 
 Sel ‘OK’ 
 Sel ‘OK’ in LCS window 
 Allow 20 sec for program to execute 
 √Yellow text displayed on desktop 

Resume LCS Ops 
P/TV-8b/130/O/A
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IDC ACTIVATION 

1. LCC Setup 
 √Hardware configured per LCC ACTIVATION steps 1,2 (Cue Card, LCS) 

 
A31p PGSC Pwr – ON 

 
2. IDC connectivity Check 
 A31p √A31p internal RJ45 Network Interface Card LED green 
 

If RJ45 Network Interface Card LED not green: 
 A15 APCU 2 CONV – OFF, wait 10 sec 

  √2 OUTPUT – ON 
APCU 2 CONV – ON  
 SM 179 POWER TRANSFER  

√PTU 2 APCU OUT VOLTS:  123V to 126V 

IDC SOFTWARE ACTIVATION 

1. IDC Software Startup 
A31p Sel ‘Shuttle Apps’ > ‘IDC’ 

 
2. Verify GMT 

A31p √GMT within 3 sec of SM-GPC GMT 
 

* 
* 
* 
* 

If GMT not within 3 sec: 
Double click on GMT box on GUI 
Adjust GMT as reqd 
Sel ‘OK’ on MTU Time dialogue box

*
*
*
*

 
3. IDC Pwr on  and self test 
 

CAUTION 
Pwr off IDC when not imaging.  Pointing IDC at Sun when 
pwr on will damage Camr

 
A31p Sel ‘Power On’  

 
 √Black and White self-test image displayed 
 √‘Waiting for User Command’ displayed 

 
* 
*
* 

If red backlit error msg displayed: 
Perform appropriate TROUBLESHOOTING 

steps on this cue card 

*
*
* 

OPERATION 

NOTE 
PDRS OPS will call for IDC image steps on LCC A31p.  Limited 
MCC real-time insight avail if configured for desktop dnlk 

 
1. Configure LDRI Illumination 

R12 (VPU) √Green Jumper – LDRI/ITVC 
A7 VID OUT MUX 1L pb – push 
 VID IN MIDDECK pb – push 
 LDRI MODE 2 pb – push 
 VID OUT MON 1(2) pb – push 
 VID IN PL2 (VPU) pb – push 
 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 CAMR CMD PAN/TILT – LO RATE within 10° 
 CAMR CMD PAN:  +85 (right) 
 CAMR CMD TILT:  -57 (down) 

 
NOTE 

If IDC GUI GMT does not update during Ops, an 
attempt to shut down/restart A31p should be made 

 
2. Auto Exposure (AE) Ops 

A31p √‘Use AE’ checked 
 Sel ‘Scan Lo-Res’ 
 Resize and posn AE box as reqd (pause 2 sec) 
 √MCC for AOI FOV 
 Sel ‘Scan Hi-Res’ 
 If Scanning with no RMS Motion: 
 Sel ‘Stop Scan’ after 30 sec 
 If scanning with RMS motion: 
 Move box to maintain RCC in AE box (using keyboard arrows) 
 Sel ‘Stop Scan’ at pause point 
 √‘Waiting for User Command’ displayed 

 
3. Scenario File Ops 

A31p From Scenario File drop-list, sel appropriate lighting condition 
 
 
 
 
 
 
 
 

 Sel ‘Acquire Set’ 
 √‘Acquiring Set’ displayed 
 √‘Waiting for User Command’ displayed after set 

√MCC content w/data take
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IDC DEACTIVATION 

1. IDC and Software Shutdown 
A31p Sel ‘Power off’ on IDC GUI > ‘YES’ 
 Close (X) IDC software > ‘YES’ 

 
2. A31p Screen Resolution Reset 

A31p Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK, ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

IDC HOT KEY COMMANDS 

F5 – Toggle Summary View F6 – Toggle Image Mode 
F7 – Zoom In F8 – Zoom Out 
F9 – Reset Brightness and Contrast F10 – Reset AE Box to Default 

F11 – Toggle AE Box Visibility F12 – Find AE Box 

IDC SOFTWARE ERROR MESSAGES 

Can’t connect to LCH:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Possible heater only mode or Network failure 
 
Iport probe failed:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport startup check failed 
 
Iport not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport connection lost 
 
Camera not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Camera connectivity lost 
 
Image acquisition failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Camera connectivity lost during imaging 
 
Network recovery failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  LCH network switch connection lost 
 
Bad initialization file:  Perform TROUBLESHOOTING, step 3 
Condition:  Software will not launch due to severe ini file corruption 

TROUBLESHOOTING 

1. LCC to LCH Connectivity Check 
A31p If Local Area Network Connection (with red X) tool tip on system tray: 

 
 
 
 
 
 

 Reseat OPP to LCC Cable (20 ft) to LCC RJ45 port 
 √Local Area Network Connection Speed 10 mps 
 If no connection: 
  Perform LCH, LCC, and IDC Reset, step 2 
 Continue nominal ops 

 
2. LCH, LCC, and IDC Reset 

A31p Exit IDC software and shut down Windows 
 √OPP to LCC Cable (20 ft) connected to LCC RJ45 port and LCS 

CMD/TLM port 
 

A15 APCU 2 CONV – OFF 
 APCU 2 OUTPUT – OFF, wait 10 sec, ON 
 APCU 2 CONV – ON 

 
 SM 179 POWER TRANSFER 
 √PTU 2 APCU OUT VOLTS:  123V to 126V 

 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 

 
 Perform IDC SOFTWARE ACTIVATION 
 Continue nominal ops 

 
3. LCC Swap 

A31p Exit IDC software and shut down Windows 
 Swap LCC with other A31p 
 Perform IDC Activation 
 Perform IDC Software Activation 
 Continue nominal ops 

P/TV-9b/130/O/A

(For SSPTS APCU 2 flights only)  (reduced copy) 
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VIDEO SETUP 

P/TV-10a/130/O/C

STOWAGE LOC
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WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)
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V
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AVIU-CC Video Cable
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J1
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J3
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R
L
V
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3
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PAYLOAD DATA INTERFACE PANEL 2 (L11)

jsc48038_130_001ccr9.cvx
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D2Xs PROGRAM 
In Cabin D2Xs Aperture Priority D2Xs Shutter Priority

“Earth Obs, RNDZ and flyaround” 
Lens – as reqd 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Lens – as reqd
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – A 

f/stop – as reqd 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 

SB-800 Flash Settings
ON/OFF pb – OFF 

 
Lens – as reqd 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – S 

SS – 500 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 

 

P/TV-11a/130/O/B

D2Xs SETUP 

TTL BL
TTL BL
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 D2Xs MANUAL 
“SUNLIT OBJECTS” 

D2Xs EXPOSURE MATCH 
“HERO SHOT” D2Xs CREW PHOTO  

Lens – as reqd 
 

NOTE 
If auto focus unachievable: 

Lens Focus Mode – M 
 

Lens Focus Mode – A 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – M 

SS – 500 
f/stop – 8 

Meter – Matrix (      ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 

ON/OFF pb – OFF 
 

Lens – 12-24mm @18mm
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – P 
Meter – Matrix (      ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                    
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Technique 
 1. Fill FOV w/sunlit subject 
 2. Activate D2Xs Camr 
 3. Auto Exp Lock – Depress,hold 
  Expect values such as 250,f/11 
 4. Focus, Frame, Fire 

Lens – 17-35mm @17mm
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – A 

f/stop – f/8 
Meter – Matrix (      ) 
Diopter – Adjust 
Frame Rate – Selftimer 

√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                    
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Accessory Equipment 
Shutter Release Cable – Install 
Multiuse Brkt – Install 
Multiuse Brkt Clamp – Install as 
reqd  

Technique 
 1. Focus on crewmember 
 2. Body Focus Mode – M 

3. Frame, Fire
 
 

TTL BL TTL BL
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DIGITAL PLAYBACK

HD DIGITAL VIA G1 DIGITAL VIA VTR 
NOTE  

Digital Playback from G1 only possible for G1 Video recordings 

ACTIVATION ACTIVATION

G1 Setup per diagram (back of cue card)
For cable strain relief, attach MPC-to-G1 Cable 
Velcro strap to CC strap 

 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
O19 √TV PWR – ON 
 
G1 PWR dial – VCR/PLAY 
 
If Dnlk 
 Notify MCC, configuring for HD TV dnlk 
 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 0,1 RATE SEL – 1 
CH √2 RATE SEL – 8 

L10 (VTR) ON/STANDBY pb – push (LED red) 
L10 (VIP) PWR – off (LED off) 
 
O19 DC UTIL PWR MNA – ON 
MPC PWR SPLY DC PWR SPLY PWR SW1 – ON 
MPC PWR – ON (5V,3V green LEDs on) 
 
L10 (MUX) √CH 2 F/O OK LED on 
 

Setup per diagram (back of cue card)
L10 (MUX) √VTR/CC PWR – on (LED on) 
L10 (VTR) √ON/STANDBY LED – green 

OPERATIONS 

PLBK or DNLK VIDEO 

L10 (VTR) Write-protect tape (red seen on tab) 
 Install tape if reqd 
 √DISPLAY SELECT – DATA 
 

If Index Search reqd: 
Remote   √ID – VTR4 

SEARCH MODE pb – push (INDEX 
SEARCH mode displayed) 

|  (  | ) pb – push to move highlight 
bar to desired GMT start 

When VTR auto-cue complete, green • 
displayed: 

PAUSE pb – push 
If playback time not displayed on DSR-25 LCD 

cycle “DATA CODE” repeatedly until time 
displayed 

L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to 
cue tape 

 
If Dnlk 
L10 (MUX) MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 3 DATA LED – on 

 
L10 (VTR) PLAY pb – push (green • displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If VTR ops complete, go to DEACTIVATION 
 

OPERATIONS
PLBK or DNLK VIDEO 

G1 Write-protect tape (red seen on tab) 
 Install tape, if reqd 
 VTR pb – REW(FF),PLAY,PAUSE to cue tape  
If Dnlk 
MPC √HDV, TAXI LEDs – on 
L10 (MUX) √CH 2 DATA LED – on 
 
G1 PLAY pb – push (green  displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If G1 ops complete, go to DEACTIVATION 

DEACTIVATION DEACTIVATION 
G1 Remove, write protect, mark, stow tape as reqd

PWR dial – OFF 
O19 TV PWR – OFF, as reqd 
 
If Dnlk 
MPC PWR – OFF 
MPC PWR SPLY DC PWR SPLY PWR SW1 – OFF 
O19 DC UTL PWR MNA – OFF 
L10 (MUX) MUX/VTR/CC PWR – off (LED off) 

√VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on, DATA FLOW LED flashes twice) 
L10 (VTR) ON/STANDBY pb – push (LED green) 
 

Notify MCC, returned to SD TV dnlk 
 

Go to DEACTIVATION (Cue Card, TV), as reqd  

L10 (VTR) Remove, mark, stow tape as reqd
Go to DEACTIVATION (Cue Card, TV) as reqd 
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HD DIGITAL VIA G1 PLAYBACK 

 

DIGITAL VIA VTR PLAYBACK 
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WELL LIT SCENE (“green”        ) SUN-LIT SCENE (M) DIM-LIT SCENE (A) 

Install Wide Conversion Lens 
as reqd 

ND FILTER – OFF (per CC prompt) 
√OUTPUT – CAM 
√A/V1/V2 – V2 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
Open LCD 

√Tape installed 

Install Wide Conversion Lens 
as reqd 

√ND FILTER – OFF 
AF/M – AF(M) 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√AUDIO LEVEL – A 
√A/V1/V2 – V2 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M 
Open LCD 

√Tape installed 
√GAIN – 0dB 

SS – 1/500 (Small Wheel) 
f/stop – F8.0 (Aft Ring) 
Adjust focus if AF/M – M (Fwd Ring) 

 
 

Install Wide Conversion Lens 
as reqd 

√ND FILTER – OFF 
AF/M – AF 
AGC – OFF 

√OUTPUT – CAM 
√AWB – ON 
√AUDIO LEVEL – A 
√A/V1/V2 – V2 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – A 
Open LCD 

√Tape installed 
√GAIN – L (M,H) per Scene 

 

P/TV-17a/130/O/A

G1 SETUP CUE CARD 
 
ASSUMPTION:  G1 is powered by either direct or battery power

 (reduced copy) 



 

 FS CC 3-28 P/TV/130/FIN A 

TOP 
BACK OF ‘G1 SETUP CUE CARD’ 

HOOK 
VELCRO 

   
 

P/TV-17b/130/O/A

 (reduced copy) 



 

 FS 3-29 P/TV/130/FIN A 

 

NOTE 
Replace this page with four (4) sheets of blue 
K-10 stock in crew copies only 

 



 

 FS 3-30 P/TV/130/FIN A 

 

NOTE 
Replace this page with four (4) sheets of blue 
K-10 stock in crew copies only 

 



 

Flight Cover (trim bottom to expose tabs) 

JSC-48038-130 
FINAL, REV A 

 

PHOTO/TV 
CHECKLIST 

STS 

130
 


	COVER
	SIGNATURE PAGE
	LIST OF EFFECTIVE PAGES
	TABLE OF CONTENTS
	SECTION 1  SCENES
	SECTION 2  REFERENCED PROCEDURES
	SECTION 3  CUE CARD CONFIGURATION
	FLIGHT COVER



